DEPARTMENT OF EDUCATION

GRADE 9

DESIGN AND TECHNOLOGY COMPUTING

UNIT 3

PRESENTATION GRAPHICS

Published by:

FLEXIBLE OPEN AND DISTANCE EDUCATION
PRIVATE MAIL BAG, P.O. WAIGANI, NCD
FOR DEPARTMENT OF EDUCATION
PAPUA NEW GUINEA
GRADE 9
DESIGN AND TECHNOLOGY-COMPUTING

UNIT 3

PRESENTATION GRAPHICS

- DESIGN AN ELECTRONIC PRESENTATION
- ADDING BASICS TO PRESENTATION
- ENHANCING PRESENTATION
- PRINTING AND SAVING
Acknowledgments

We acknowledge the contributions of all Secondary Teachers who in one way or another helped to develop this Course.

Our profound gratitude goes to the former Principal of FODE, Mr. Demas Tongogo for leading FODE team towards this great achievement. Special thanks to the FODE IT Edit Team and SRC Members who played an active role in critiquing and editing to ensure quality control for this Course.

We also acknowledge the professional guidance provided by the Curriculum Assessment Division throughout the process of writing especially to the late Mr. Tobias Gena.

The development of this book was co-funded by GoPNG and World Bank.

DIANA TEIT AKIS
PRINCIPAL

Written and Compiled by Mrs. Clyte D. Cerica.

First Published in 2017 by Flexible Open and Distance Education, Papua New Guinea.

Printed by Flexible Open and Distance Education


National Library Services of Papua New Guinea
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>TOPIC 1: DESIGNING AN ELECTRONIC PRESENTATION</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lesson 1 Planning the Concept of a Presentation</td>
<td>9</td>
</tr>
<tr>
<td>Lesson 2 Creating a Presentation Story Board</td>
<td>17</td>
</tr>
<tr>
<td>Lesson 3 Customising Toolbars and Menus of a Microsoft PowerPoint Presentation</td>
<td>24</td>
</tr>
<tr>
<td>Lesson 4 Creating an Outline for a Presentation</td>
<td>33</td>
</tr>
<tr>
<td>Lesson 5 Saving a Presentation</td>
<td>46</td>
</tr>
<tr>
<td>Lesson 6 Viewing a Presentation</td>
<td>57</td>
</tr>
<tr>
<td>Answers to Practice Exercises 1 – 6</td>
<td>66</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TOPIC 2: ADDING BASICS TO PRESENTATION</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lesson 7 Adding a Design Template</td>
<td>71</td>
</tr>
<tr>
<td>Lesson 8 Customising the Background of a Presentation</td>
<td>77</td>
</tr>
<tr>
<td>Lesson 9 Inserting Graphics, Clip Art, and/or Digital Pictures to a Presentation</td>
<td>87</td>
</tr>
<tr>
<td>Lesson 10 Using WordArt in a Presentation</td>
<td>96</td>
</tr>
<tr>
<td>Lesson 11 Adding Graphics from the Internet</td>
<td>105</td>
</tr>
<tr>
<td>Lesson 12 Adding Animation Schemes</td>
<td>111</td>
</tr>
<tr>
<td>Answers to Practice Exercises 7 – 12</td>
<td>116</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TOPIC 3: ENHANCING PRESENTATION</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lesson 13 Adding a Hyperlink to a Presentation</td>
<td>120</td>
</tr>
<tr>
<td>Lesson 14 Inserting a Chart to a Presentation</td>
<td>130</td>
</tr>
<tr>
<td>Lesson 15 Inserting a Sound File to a Presentation</td>
<td>146</td>
</tr>
<tr>
<td>Lesson 16 Inserting Video File to a Presentation</td>
<td>149</td>
</tr>
<tr>
<td>Lesson 17 Adding Custom Animation to a Presentation</td>
<td>157</td>
</tr>
<tr>
<td>Lesson 18 Adding Slide Transition to a Presentation</td>
<td>163</td>
</tr>
<tr>
<td>Answers to Practice Exercises 13 – 18</td>
<td>171</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TOPIC 4: PRINTING AND SAVING</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lesson 19 Printing Slide</td>
<td>175</td>
</tr>
<tr>
<td>Lesson 20 Printing Handouts</td>
<td>181</td>
</tr>
<tr>
<td>Lesson 21 Saving a PowerPoint Show</td>
<td>187</td>
</tr>
<tr>
<td>Lesson 22 Saving Presentation as a Web Page</td>
<td>194</td>
</tr>
<tr>
<td>Lesson 23 Saving with Pack and Go</td>
<td>203</td>
</tr>
<tr>
<td>Lesson 24 Evaluating the Presentation</td>
<td>210</td>
</tr>
<tr>
<td>Answers to Practice Exercises 19 – 24</td>
<td>223</td>
</tr>
</tbody>
</table>
SECRETARY’S MESSAGE

Achieving a better future by individual students and their families, communities or the nation as a whole, depends on the kind of curriculum and the way it is delivered.

This course is a part of the new Flexible, Open and Distance Education curriculum. The learning outcomes are student-centred and allows for them to be demonstrated and assessed.

It maintains the rationale, goals, aims and principles of the national curriculum and identifies the knowledge, skills, attitudes and values that students should achieve.

This is a provision by Flexible, Open and Distance Education as an alternative pathway of formal education.

The course promotes Papua New Guinea values and beliefs which are found in our Constitution, Government Policies and Reports. It is developed in line with the National Education Plan (2005 -2014) and addresses an increase in the number of school leavers affected by the lack of access into secondary and higher educational institutions.

Flexible, Open and Distance Education curriculum is guided by the Department of Education’s Mission which is fivefold:

To facilitate and promote the integral development of every individual
To develop and encourage an education system satisfies the requirements of Papua New Guinea and its people
To establish, preserve and improve standards of education throughout Papua New Guinea
To make the benefits of such education available as widely as possible to all of the people
To make the education accessible to the poor and physically, mentally and socially handicapped as well as to those who are educationally disadvantaged.

The college is enhanced to provide alternative and comparable pathways for students and adults to complete their education through a one system, many pathways and same outcomes.

It is our vision that Papua New Guineans’ harness all appropriate and affordable technologies to pursue this program.

I commend all those teachers, curriculum writers, university lecturers and many others who have contributed in developing this course.

UKE KOMBRA, PhD
Secretary for Education
UNIT INTRODUCTION

Unit 3 is Presentation Graphics where you will learn about the basic concepts of PowerPoint Presentation. The Unit consists of the following four Topics which will help you understand what a computer is.

<table>
<thead>
<tr>
<th>Topic 1:</th>
<th>Designing an Electronic Presentation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic 2:</td>
<td>Adding Basics to Presentation</td>
</tr>
<tr>
<td>Topic 3:</td>
<td>Enhancing Presentation</td>
</tr>
<tr>
<td>Topic 4:</td>
<td>Printing and Saving</td>
</tr>
</tbody>
</table>

By the end of this Unit, you will be able to use a presentation graphics application, design and create graphic presentations for a range of purposes, use ethical practices when dealing with information and computer technology. This understanding of the fundamentals of PowerPoint will enable you to move a step higher in gaining the necessary knowledge, skills and attributes in computing.
Below are the steps to guide you in your course study.

**Step 1:** Read each lesson in the Unit Book carefully. In most cases, reading through a lesson once is not enough. It helps to read something over several times until you understand it. You are not expected to memorise the information in the Unit Book. You should use it as a reference and to learn from the examples given to illustrate important points.

**Step 2:** After reading the summary of the lesson, start doing the Practice Exercise. You must do only one practice exercise at a time. Then mark it according to the following instruction.

**CHECK YOUR ANSWERS AT THE END OF TOPIC 1.**

**Step 3:** After marking your answers, go back to the lesson and correct any mistakes you may have made. Then move on to the next lesson.

**Step 4:** After completing all the Practice Exercises, do Assignment 1.

**Step 5:** Now send the completed Assignment booklet to your FODE Provincial Centre for marking.

Follow all these steps 1 - 5 when completing all Unit Books.

**Be honest with yourself** when you are doing and marking your Practice Exercises as well as completing your Assignment Booklets.

This Unit has a separate assignment booklet for you to use. The information at the end of the last lesson in every Topic will let you know what to do with the assignment exercises. Whenever you need help and advice, contact your tutor or your Provincial Coordinator for assistance. If you are in the NCD or Central Province, we are available on Mondays to Fridays. You can call in anytime between 8 a.m. and 4 p.m. We would be glad to help you.

The following icons are used in each Lesson in this Unit. Icons are the symbols used in this book to indicate the parts of your lessons. The following are the meanings of these icons.

![Lesson icons]

Whenever you need help and advice, contact your tutor in the Information Technology Department at FODE.

We hope you enjoy learning this course. All the best!

*Your Tutor*

Information Technology Department, FODE
TOPIC 1

DESIGN AN ELECTRONIC PRESENTATION

Lesson 1: Planning the Concept of a Presentation
Lesson 2: Creating a Presentation Story Board
Lesson 3: Customising Toolbars and Menus of a Microsoft PowerPoint Presentation
Lesson 4: Creating an Outline for a Presentation
Lesson 5: Saving a Presentation
Lesson 6: Viewing a Presentation
TOPIC 1: DESIGNING AN ELECTRONIC PRESENTATION

In this topic, you will learn the basic concepts of PowerPoint. The Topic is designed to familiarise you with the terminologies and icons used in PowerPoint. It also aims for you to gain basic understanding of creating a PowerPoint Presentation.

In the previous units you have studied the Computer Basics, and the Introduction to Word Processing. In this unit, you will be studying how to create a PowerPoint Presentation, and the importance and uses of PowerPoint.

In this topic, you will study about the following:

**Lesson 1** is all about the definition of PowerPoint. You will be introduced to the PowerPoint Screen and be familiar with the function of each element.

**Lesson 2** is all about creating a Presentation Story Board. You will learn how to prepare your presentation using the Story Board technique.

**Lesson 3** is all about the Menus and Toolbars. You will learn the use and location of Menu and the Toolbars.

**Lesson 4** is all about Creating an Outline for a Presentation. You will learn the proper way of outlining the topic for your presentation.

**Lesson 5** is all about Saving a Presentation. You will learn the proper way of saving a presentation.

**Lesson 6** is all about Viewing a Presentation. You will learn the different ways of viewing a presentation.
Lesson 1: Planning the Concept of a Presentation

Welcome to Lesson 1 of Unit 3. In the previous Unit you learnt how to create and modify documents using Microsoft Word.

In this lesson, we are going to learn another application called Powerpoint. You will be asked to explain the meaning of powerpoint. You will also learn the short history of PowerPoint Presentation. Later in the lesson, you will discuss the purpose of PowerPoint Presentation and enumerate the steps in planning the concept of a PowerPoint Presentation.

**Your Aims:**
- define PowerPoint Presentation
- plan the concept of a Power Point Presentation

Let us now start our topic, firstly let us look at the definition of PowerPoint and then learn about its origin.

**PowerPoint** is a presentation program developed by Microsoft. It is included in the standard Office suite along with Microsoft Word and Excel.

PowerPoint is often used to create business presentations, but can also be used for educational or informal purposes as well as a presentation is made up of slides (see picture of a slide on the next page), which may contain text, images, and other media, such as audio clips and movies. Sound effects and animated transitions can also be included to add extra appeal to the presentation.

Before we move on, let us look back and see how PowerPoint has come to start. Did you know that before Powerpoint came along, anyone who wanted a visual aid for their presentation would have to spend a lot of time writing on a board?

It was Bob Gaskins and Dennis Austin from the University of California-Berkeley who developed the first version of PowerPoint in the year 1984 and it was called Presenter; it was later improved by Microsoft and renamed as MS PowerPoint.

**Starting the PowerPoint Program**

Now that we have learnt a little about the background of PowerPoint let us now try to start the program. The following steps are recommended for beginners. Keep on reading and following. Do not skip any page or part of the lesson.

1. On your desktop, click the **Start** button to display the start menu.
2. Point your mouse pointer to **All Programs** and browse to Microsoft Office icon then click on Microsoft Powerpoint.

---

**Step 2 a**

- **Microsoft Office**
- **Microsoft PowerPoint**

**Step 2 b**

- Click on Microsoft PowerPoint.

---

**Step 2 c**

- **All Programs**
- **Microsoft Office**
- **Microsoft PowerPoint**
3. You have done it, if you have followed the instructions well, you will see the PowerPoint screen just like the one below. If you got lost, you can go back to Step 1 and start over again.

![The PowerPoint Screen with one slide]

**Activity 1: Write a brief explanation on the following questions.**

1. Seeing the PowerPoint screen for the very first time, can you identify some differences between PowerPoint and Microsoft Word which you covered in in Unit 2.

2. If PowerPoint was never invented, how do you think the people of today would create their presentation? Give at least two examples.

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.

**Parts of the PowerPoint Screen**

On the earlier part of this lesson you learnt to open the PowerPoint program for the very first time and saw what it looked like. Now, we are going to identify the different parts that make up the PowerPoint program window.
These are the parts of the PowerPoint Screen. Study them.

1. **Title Bar** - displays the presentation's name followed by a program name.
2. **Ribbon Bar** - contains a list of options to work with and or customise presentations.
3. **Quick Access Toolbar** - contains shortcut buttons for the most popular commands.
4. **Outline/Slides Pane** - is located on the left side of the screen. Click on the tabs to view an outline or a slide of your presentation. The tabs render differently based on the size of the pane.
5. **Status bar** - shows the current slide number and position of the insertion point in the document.
6. **Task Pane** - located on the right side of the PowerPoint window, this pane allows you to select tasks in different categories and allows you to quickly enhance your slides in a few steps. It provides quick access to the most common actions and features in PowerPoint.
7. **Slide** - is a single page of a presentation. This is where all the presentation objects are placed when creating a presentation.
8. **Notes Pane** - appears at the bottom of the screen. Click on the notes pane to add, edit, or delete notes that relate to each slide’s content. The notes on this part can be printed together with the presentation.

---

**Activity 2:**  **Select the best response. Circle the letter of your answer.**

1. Which of the following parts of the PowerPoint program window displays all slides in the presentation as a miniature or as a small image?
   A. slide pane
   B. standard toolbar
   C. slides tab
   D. ribbons

2. Every slide in a presentation has a notes section, which contains:
   A. space for speaker notes
   B. slide image
   C. both of the above

3. When you create a new, blank presentation, PowerPoint:
   A. adds one slide to it with the Title Slide layout applied
   B. allows you to select different layouts or formats
   C. both of the above

4. A new slide can contain which of the following objects:
   A. chart, table or movie.
   B. chart, movie or formula.
   C. movie, picture or function.
   D. formula, function or picture.

5. In the PowerPoint window, what is the main area for adding slide content?
   A. The notes pane.
   B. The Slides tab, on the left of the PowerPoint screen.
   C. The slide pane, in the middle of the PowerPoint screen.

---

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.
Planning the Content of a Presentation
You are now becoming good in PowerPoint. At the start of this lesson you learned the definition of PowerPoint, on the earlier topic we have identified the different parts of the PowerPoint program window. In this part of the lesson we are going to learn how to plan a presentation.

Planning is the most important step in creating a successful presentation. Planning helps you decide on what text to put and the order in which the information will be presented. Use the following steps as a guide in planning the presentation.

1. Decide the Purpose of the Presentation
   - Is this presentation about a product for a client?
   - Is it a business presentation about the latest sales figures?
   - Is it about a new idea you are introducing?

2. Find out the Presentation’s Audience
   - your staff
   - a new future client
   - a group of small children

3. Collect Your Information
   - Remember the KISS principle (Keep It Simple Silly) when designing your presentation.
   - Focus on three or four main topic only
   - Know everything about the topic so you are ready for questions after the presentation.

4. Plan Out the Slides on Paper
   - Make sure the slides emphasize the main points to be made in the presentation.
   - Try to have only one main idea on each slide.
   - List no more than four points per slide.

5. Decide the Order Of Your Slides
   - Although this can be changed later, having a rough idea of the order of your topic points, will help you plan the order of your slides.

6. Create the Presentation
   - When creating the slides, be consistent in your choice of background colours, fonts, transitions, and animations.

Transitions are the animation-like effects that occur in Slide Show view when you move from one slide to the next during a presentation.
Activity 3: Write a brief explanation about the question.

1. What do you think will happen to a presentation when there is no planning done?

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answer. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Summary
You now have come to the end of Lesson 1. In this lesson you have learned the definition of PowerPoint. You also read a brief of PowerPoint history and identified the parts that make up PowerPoint. Finally you gained information on how to plan for a presentation.

NOW DO PRACTICE EXERCISE 1 ON THE NEXT PAGE
Practice Exercise: 1

A. Identify the term that best matches the definition given. Write your answer on the space provided before each item.

1. This is the part of the PowerPoint Program Window that shows the Outline and Slide view of your presentation.
2. This helps you in arranging your presentation.
3. This lets you create presentations of any kind.
4. This is what you click on the desktop to see the Start Menu.
5. This is the part of the PowerPoint program window that shows the title and subtitle of your presentation.
6. This was the original name of PowerPoint.
7. This part of the PowerPoint program window contains “Microsoft PowerPoint – [Presentation 1]” if the PowerPoint Presentation has not yet been saved.
8. PowerPoint is part of this Microsoft Program Suite.
9. This is the pane that helps you enhance your slide.
10. This is the toolbar that helps you create objects in your presentation.

Answers to Activity 1

1. PowerPoint screen differs from Microsoft Word’s screen in several ways. Firstly, instead of documents, there are slides. There also the Slide Pane and the Notes pane which are not part of Microsoft Word.

2. If PowerPoint was not invented people today would still be writing all their work using the board. They would still be cutting up or drawing pictures and pasting them on a system board before putting it up for people to see.

Answers to Activity 2


Answer to Activity 3

1. If there is no planning on how topics will appear on a Presentation, the presentation might become difficult to understand for the audience, therefore, making the presentation ineffective.
Lesson 2: Creating a Presentation Story Board

Welcome to Lesson 2 of Unit 3. In Lesson 1, you were introduced to Microsoft PowerPoint. You were able to define its meaning, identify its parts, and discovered how to plan a good presentation.

In this lesson, you will learn about the purpose and features of a Presentation story board and list down. You will also describe the steps to take in creating a Presentation Story Board. Finally, you will create a presentation story board using the given steps and appreciate the importance of creating a Presentation Story Board.

Your Aims:
- define Presentation story board
- identify the parts of a Presentation story board
- create a Presentation story board

Storyboard

In Lesson 1 we had a first look at PowerPoint, we defined what PowerPoint is and identified its parts, we also learned how to plan a PowerPoint presentation.

Storyboard is a sequence of drawings, typically with some directions and dialogue, representing the shots planned for a movie or television production.

Storyboard is a simple technique for planning a presentation. After you decide what you are going to present and what your presentation purpose is, use a flowchart to plan how you are going to present that information in order to achieve your goal.

Flowchart is a diagram of the order of operations in a computer program.

Creating a Storyboard has the following advantages:
- Storyboard promises you that the information you present will finally lead you to your purpose.
- Storyboard help you to organise the information that you are going to present and make it easier for you to decide what you're going to say and when you're going to say it.
- A storyboard also makes it easy to start planning slides - all of the boxes on the storyboard are going to go into the presentation, so all you have to do is work out how to spread them throughout a PowerPoint presentation.
- Storyboarding saves you time by avoiding guesswork.
A storyboard has two main parts, the images or pictures and the explanation of the picture.

**Activity 1:** Create a caption/explanation for the following images, your explanation should create a story between the images. Put your caption in the box provided below each image.

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.

**Steps in Creating a Storyboard**
Let us now look at the steps in creating a Storyboard using the PowerPoint program. It is recommended that you have a working computer with a PowerPoint program during this lesson.

1. List down the parts you need for the first slide in your frame. You will make one PowerPoint slide for each storyboard frame. For example in this lesson, we will put in our first frame a person exiting a house. You can write "person," "man" or "woman," "house" or "flat."
2. From the ribbon bar, position your mouse pointer over the "Insert" Menu tab and then left click, under the Images group, click "Clip Art" button.

   ![Clip Art](image)

   **Clip Art** is a pre-made images used to show any forms of objects.

3. After clicking Clip Art, the task pane (remember that task pane is located at the right side of the PowerPoint screen) will open the Clip Art tools pane. Type the name of one of the subject you listed earlier into the tool box in the text box labelled "Search for". Refer to the image below to see if you have identified the task pane from your PowerPoint screen.

   The image here is the taskpane. This is normally located on the right side of the PowerPoint Window.

   ![Clip Art Task Pane](image)

   Type the name of the subject you listed on the first step. For this lesson, type 'house'. Click the Go button to show the images.
4. Click the "Go" button to perform the search.

5. Select a picture from the images found in the search then, click and drag the image onto your slide. Using the example of this lesson, you would click and drag a house icon from the search results onto your slide.

6. Size the picture to your liking by dragging on any of the graphic's bluish square or circular handles. Rotate the graphic to the orientation you need by dragging the graphic's green circle above the graphic. Use the figure below to help you.

7. To insert an image from a USB (Universal Serial Bus) or Flash Drive or a camera. Position your mouse on the Insert Menu and browse option.

8. When a pop-up menu opens, click the 'From File' (earlier we used Clipart) command. The insert Picture window will appear. There might be several or few pictures appearing in your screen. It does not matter but what matters is the name of the folder these pictures are located in. By default PowerPoint searches for pictures directly from the 'My Pictures' folder. Locate the picture from your desired location to insert it in your slide.
9. Once you have found the picture that you want for your Storyboard, click the image. Then click the insert button (found on the lower right corner of the Insert Picture screen) Resize the imported pictures the same way you did the Clip Art graphic in Step 6.

10. Click the \_Insert Menu tab\' and then click the \"New slide\" command on the \"Slides\" panel to insert a slide for the next frame in your storyboard.

11. Repeat the previous steps in inserting Clipart or picture from files for each remaining frame in your storyboard.

12. Click the \"View\" menu heading and then click the \"Slide show\" button in the \"Presentation\" panel to view your storyboard.

13. Insert a textbox below each image to add a caption.

14. Your work will look similar to the image below. Do not worry if there is a slight difference between your work and the one illustrated below.

Activity 2: Write a brief explanation on the question given.

1. How does storyboard add excitement to your presentation?

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.
Summary
You now have come to the end of Lesson 2. In this lesson you have learned
the definition and purpose of storyboard. You also went through the step by
step procedure in creating storyboard for PowerPoint.

NOW DO PRACTICAL EXERCISE 2 ON THE NEXT PAGE.
Practical Exercise: 2

A. Create a Storyboard using PowerPoint Presentation.

1. Open PowerPoint application and create a 3 slide storyboard about a boy coming home from school.
2. Use the clipart to choose the images for your storyboard.
3. Provide a caption at the bottom of each image to describe what the image represents.

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 1.

Answers to Activity 1

(Possible answers only. Answers vary on the students imagination)

This is my country, Papua New Guinea.

Our most famous flower is named Bird of Paradise.

Our most famous bird is named Bird of Paradise as well.

Answers to Activity 2

1. Storyboard adds excitement to a presentation because it uses images to enhance the presentation. It does not use plain text but tells a story with a corresponding images.
Lesson 3: Customising Toolbars and Menus of a Microsoft PowerPoint Presentation

Welcome to Lesson 3 of Unit 3. In Lesson 2, you defined Presentation story board, identified the parts of a Presentation story board and created a Presentation story board.

In this lesson, you will learn about the meaning and purpose of Toolbars and Menus. You will also locate toolbars and different menus and enumerate and explore the Toolbars from the computer. Moreover you will learn the proper use of Menus in MS Power Point and enumerate the steps in customising toolbars and menus. Finally, you will learn the importance of customising toolbars and menus.

Your Aims:
- define Toolbars and Menus
- customise toolbars and menus
- identify the different tool bars for Presentation creation
- identify the proper use of menus in Microsoft Power Point

The Menu Bars and Toolbars

Read the following explanation of Ribbons and Quick Access Toolbar then answer the questions that follow.

A Ribbon is a horizontal strip that contains lists of available Tabs, Groups, & Commands for a program. In PowerPoint, the ribbon bar resides at the top of each window. When PowerPoint starts, the Ribbon displays the full range of tabs, groups, & commands. Look at the image below and see how a Menu bar looks like.

Note: The ribbon bar which is new with Microsoft Office PowerPoint 2007 and 2010 has replaced the menu bar of Microsoft Office PowerPoint 2003.

The Ribbon Bar

A Quick Access Toolbar is by default found across the top (it can also be re-positioned, so it appears as a vertical bar on the sides of the PowerPoint screen), that contains buttons that execute the most frequently used command. Look at the image below for an example of the Quick Access Toolbar.
Select Chevron (▼) to see all of the possible buttons which are available for the Quick Access Toolbar. Those with ticks actually appear on the toolbar (some of them might be hidden).

We have already defined the meaning of ribbon bar and Quick Access toolbars, we have also seen how they look like, but you might be wondering, what could be the purpose of the ribbon bar and quick access toolbars? Let us take a closer look now.

The ribbon bar's purpose is to provide a place for PowerPoint menu tabs to group common functions together. Tabs provide access to functions as opening files, interacting with an application, or displaying help documents.

The Quick Access Toolbar's purpose on the other hand is for ease of access to most commands. Instead of searching for a command option on the Menu tabs. As an example, if you want to save a file, you can directly click on the toolbar buttons to accomplish the task rather than going to the Home Menu tab to look for the save command. That way is quicker hence the Quick Access Toolbar.

Activity 1: Based on your readings, list the importance of the ribbon bar and the Quick Access toolbar.

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Purpose of the Menu Bar and the Toolbar
Based on the previous section, we defined and discovered the purpose of a Ribbon bar and the Quick Access toolbar. Now, we are going to learn about the different Tabs and Commands usually found on the Ribbon bar.

Take a look at the image of the PowerPoint screen shown below. The ribbon bar is located at the top of the screen just below the title bar.

Move your mouse pointer over the word **Insert** and click with the left mouse button to make the **Insert Tab** active.

You will notice that some of the commands appear very light in colour. This means they are not available for selection at the moment. **Arrows** appear at the bottom of the list and will expand the command if clicked on.

Try the next tab. Move your mouse pointer over the tab **Design** and click with the mouse button to open the **Design** tab. Now let us move on to the other tabs. How about you try to move your mouse pointer over **Transitions** tab, and click with the mouse button. Go on and explore the other tabs by clicking on them.

By now, you should be familiar with tabs and know how to open them in the ribbon bar.

Click on the **Slide Show** tab to open it. Click the **Set Up Slide Show** option to display the **Set Up Show** dialog box. The Set Up Show **dialog box** looks like the image on the next page.
A. List the nine menu tabs found in the ribbon bar.

1. ________________________________________

2. ________________________________________

3. ________________________________________

4. ________________________________________

5. ________________________________________

6. ________________________________________

7. ________________________________________

8. ________________________________________

9.  ________________________________________

B. List the possible command buttons that you can add to the Quick Access Toolbar.

1. ________________________________________

2. ________________________________________
Thank you for completing this activity. Now, you may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Customising Ribbon bar and Quick Access Toolbars

You have done well with the Ribbon and Quick Access Toolbar, but, we are not yet done. Now that we know where to look for tabs and quick access toolbar and how to make them appear, we will now try to customise the ribbon bar and quick access toolbars.

However, before we do that, let us first find out why there is a need to customise them. The following are some of the reasons for customising the ribbon bar and Quick Access toolbars:

1. To help you work very well
2. To allow you to spend less time searching through menus
3. To give you more time on doing your presentation

Now that we knew the reasons for customising the ribbon bar and quick access toolbar. Let us learn how to customise them.

Adding Buttons to Quick Access Toolbar

You will recall that the Quick Access toolbar as the bar across the top, that contains buttons which execute commands when you click them. We will now learn how to add buttons to a Quick Access Toolbar. Follow the steps and never skip an action.

1. Position your mouse over the chevron button on the quick access toolbar and click your mouse, after clicking a pop-up menu of possible buttons will appear. If you have done the right thing you will have a screen that is similar to the image on the next page.
2. If it is not yet selected click on the **Quick Print** option, your Quick Access toolbar should now look like the one below.

![Quick Print button on Quick Access toolbar]

Well done! You have just added a new button to our quick access toolbar. But what if you do not need the button anymore and it only occupies space on your toolbar? The next set of steps is going to show you how to remove a button from the toolbar. Follow the steps and do not skip any item.

1. Put your mouse over the chevron of the quick access toolbar and click it.
2. Click the name of the button that you wish to remove from the quick access toolbar.
3. Notice that the button is no longer on the Quick Access Toolbar.

We have done a good job in adding and removing button on the quick access toolbar. Let us now try to customise the ribbon bar by deleting a tab from the ribbon bar. Follow the steps and do not skip any item.

**Step 1** Right-click anywhere on a tab and a pop up menu will appear, select **Customise the Ribbon**

![Customise the Ribbon]

Select the Customise the Ribbon
Step 2  The PowerPoint Options dialog box will appear. Select the Customise Ribbon option.

Step 3  On the Customise Ribbon group, untick the Home under the Main Tabs by clicking inside the box.
Step 4  Click OK.

Activity 3: Write a brief explanation.

1. Based on what we have covered and the practical exercise that we have done in customizing the quick access toolbar and ribbon bar, the **Customise option** is always part of the steps. What do you think is the purpose of the Customise option?

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________
___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Summary

You now have come to the end of Lesson 3. In this lesson you have learned the definition and importance of Ribbon bars and Quick Access Toolbars, You have also learned to customise their settings.

NOW DO PRACTICE EXERCISE 3 ON THE NEXT PAGE
Practice Exercise:  3

A. Complete the following sentences by filling in the missing word.

1. A __________ indicates that there are more quick access toolbar options in the list.

2. The __________ menu appears when you right click the ribbon bar.

3. The __________ command can be used to add or remove a button from the ribbon bar.

4. There are nine __________ on the ribbon bar, that can be used to add, enhance and control a PowerPoint presentation.

5. What is the name of this icon? __________

Answers to Activity 1

1. Ribbon bar holds a place for all the tabs in PowerPoint. Clicking on a tab reveals a list of commands. The Quick Access toolbar on the other hand serves as an easy access to regularly used commands. Toolbar contains buttons of commands that can be activated by a single mouse click.

Answers to Activity 2

<table>
<thead>
<tr>
<th>The nine Tabs</th>
<th>The eleven button for Quick Access Toolbar</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. File</td>
<td>1. New</td>
</tr>
<tr>
<td>2. Home</td>
<td>2. Open</td>
</tr>
<tr>
<td>3. Insert</td>
<td>3. Save</td>
</tr>
<tr>
<td>4. Design</td>
<td>4. Email</td>
</tr>
<tr>
<td>5. Transitions</td>
<td>5. Quick Print</td>
</tr>
<tr>
<td>6. Animations</td>
<td>6. Print Preview &amp; Print</td>
</tr>
<tr>
<td>7. Slide Show</td>
<td>7. Spelling</td>
</tr>
<tr>
<td>8. Review</td>
<td>8. Undo</td>
</tr>
<tr>
<td>9. View</td>
<td>9. Redo</td>
</tr>
<tr>
<td></td>
<td>10. Slide Show from Beginning</td>
</tr>
<tr>
<td></td>
<td>11. Open Recent File</td>
</tr>
</tbody>
</table>

Answer to Activity 3

a. The customise command contains the list of commands that can be added or removed from quick access toolbars and ribbon bars. If the customise button is not opened before adding or removing commands, the action cannot be done.
Lesson 4: Creating an Outline for a Presentation

Welcome to Lesson 4 of Unit 3. In Lesson 3, you were introduced to toolbars and menu bars. You learnt their importance, and the the purpose of customising them. You also had hands-on practice on how to customise the toolbars and the menu bars.

In this lesson, you will learn about creating an outline for a presentation, and identifying the steps in locating and learning how to create an outline for view and editing using identified steps. Finally, you will enumerate the importance of creating an outline for view and editing.

Your Aim:

- create an outline for view and editing

Outline for Presentation

An outline is a blueprint or plan of your presentation. The following are the reasons why it is important to outline a presentation:

1. It highlights the key logical elements, for example, what points are being made to logically support the core message.
2. It highlights the key structural elements of the presentation such as the introduction, body, conclusion and high-level concepts.
3. The outline can also map out the transition between elements of your presentation.
4. It allows you to better structure your ideas
5. It allows you to move the text around your presentation when necessary.
6. It helps you to quickly develop your presentation.

An outline within a PowerPoint presentation simply means, “all the text that can be found in the presentation that are inserted within any of the text placeholders.”

Although pictures, music, and other slide objects can play an important role within a presentation, a proper outline is still the main frame on which the body of a presentation can be sustained. Without a solid outline, everything else is likened to a movie that has the great music with talented cast but no story everything together.

Placeholder is a box with a dotted outline. It designed for the placement of content on the slide. This placeholder is most commonly used for text.
1. What is a presentation outline? __________________________________

2. State the six (6) reasons why an outline is important when preparing a presentation.
   a. ________________________________________________________
   b. ________________________________________________________
   c. ________________________________________________________
   d. ________________________________________________________
   e. ________________________________________________________
   f. ________________________________________________________

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Creating an Outline
The next part of our lesson will be hands-on. It means you need to have a working computer with PowerPoint installed. We will follow a step by step procedure. The topic that you will be putting on your presentation is prepared for you as well. Do not skip any reading and follow each step very well. If you get lost in the process, you can always go back to the previous step. Let us now begin our hands-on lesson.
1. Open PowerPoint application on your computer. The first time you open PowerPoint a new blank presentation is opened. You can see it on the slides pane.

2. In the Slide pane, click on the “Click to Add title” placeholder.

A selection box surrounds the placeholder, and a blinking insertion point appears in the center of the box, indicating that the text you type will be centered in the placeholder.

**Insertion Point cursor** is the short flashing marker which indicates where your next typing will begin.

3. Type The Taguien Cycle (please take note, that text appears in bold in this lesson to stress the text you are to type on your slides, but text should all be written in normal font on your slides).

PowerPoint’s spell-checking feature indicates with a red wavy underline that Taguien is a possible spelling error. This word is a proper name and is correct. So you can just simply ignore this error. Compare your work to the image on the next page.
4. In the Outline/Slides pane, click the Outline tab, and notice that the text you typed also appears there.

5. In the Slide pane, click on the "Click to add Subtitle placeholder."

The title placeholder is deselected, and the subtitle placeholder is selected. Type "A New Series for Young Adults", and then press ENTER to move the insertion point to a new line in the same placeholder.

Deselect means to un-select something.

6. Type "Judy Lew, Project Editor", on the next line, you should now have three lines of text on your first slide as shown in the diagram on the next page.
7. In this step you will first save your work before you proceed with your Presentation. You need to save your work in cases of black outs, or accidental shut down of the computers. Your work will not be lost. Follow the sequence of letters for instructions of saving your PowerPoint Presentation.

a. On the menu bar, move your mouse pointer over the File Tab, and click it.

b. From the drop down menu, click save, the images below will show you how to do it correctly.

Please remember: As you type titles and bullet points in this entire lesson, do not put a period at the end.
c. On the Save As Screen, go down to the filename box and type **Proposal**. Look at the **Save in:** which is located at the top. This shows you in which folder you will be saving your work, as a default the Save in: contains **My Documents**. Remember the folder name, so the next time you open your computer you will know where to look for your file. Look at the image below and compare your screen to it. They should be similar.

- **Save in:**
- **File name:** Proposal
- **Save as type:** Presentation (*.ppt)

You will note that the title —Presentation1” was now replaced with —Proposal”. If you are seeing —Proposal” in your title bar, then you have followed the steps correctly. If you still see —Presentation1”, kindly go back to the previous steps and self check where you made a mistake or skipped a step.

8. The next step is to Add a new slide with the Title and Content layout. This will open our second slide for this presentation.

Move your mouse pointer over the Slide/Outline pane and **right-click**, a pop-up menu will open. From the pop-up menu select **New Slide**, on the slides pane you will observe that a new slide has been created, and on the Outline/Slides pane a thumbnail of the new slide appears. Check your work with the image on the next page, to make sure you have done the right thing.
9. Without clicking anywhere with your mouse, type **Rationale**

If you start typing on an empty slide without first selecting a placeholder, PowerPoint enters the text into the title placeholder. The title appears on both the slide and the Outline tab.

10. On the Outline tab, click to the right of **Rationale**, and then press ENTER on the keyboard.

    PowerPoint adds a new slide to the presentation, and an icon for Slide 3 appears in the Outline pane. You can refer to the image below to see if you have done the right thing.

    Clicking on the right of the **Rationale** text and then pressing enter created Slide number 3.
11. Press the TAB key on the keyboard.

The Slide 3 icon changes to a bullet on Slide 2. The bullet is gray until you enter text for the bullet point.

Please remember: The TAB key is located on the left side of the keyboard, just above the CAPS LOCK key.

12. Now go ahead and type in the following text after the bullet point **Lucerne currently has no offering for young adults** (Please note that text are not written in bold), and then press ENTER.

PowerPoint adds a new bullet at the same level.

13. Type this next text on the second bullet that appeared **Fantasy series have been hits in this hard-to-please market** (Please note that text are not written in bold), and then press ENTER.

14. Type this next text on the third bullet that appeared: **Customers are turning to other publishers to meet demand** (Please note that text are not written in bold), and then press ENTER.
15 Press SHIFT+TAB (This is a special key), to do this press and hold down the SHIFT key and the TAB key together.

Please remember: The SHIFT key can be located on the left side of the keyboard, just below the CAPS LOCK key, and the other SHIFT key is located on the right side, just below the ENTER key.

On the outline tab, the bullet changes into an icon for Slide 3. The new slide is displayed in the Slide pane.

16 Type Characteristics of a Good Fantasy Series, press ENTER, and then press TAB.

This slide title is too long to fit in the title placeholder at its default font size, so PowerPoint decreases the size to make it fit. This is because Autofit is enabled.

17 Type A teacher, press ENTER, type An adversary, press ENTER, type A hero, and then press ENTER.

18 Press TAB key from your keyboard. PowerPoint creates a subpoint, a subpoint indicates a list within a list.

19 Type Innately sympathetic, press ENTER, type Reluctant rebel, press ENTER, and then type Untested Potential.

20 Press CTRL + ENTER.

Instead of creating another bullet, PowerPoint creates a new slide.
Put your mouse pointer over the File menu and click , and on the drop down menu click save. Since we have already saved this document before, we were not asked to provide a filename again. All it did is update the file by saving the changes you made.

Always save your work to avoid loss of your work. You can click File menu, and browse to Save and click it, or press CTRL+S for keyboard shortcut of Save.

Activity 2: Complete the following sentences by filling in the missing word.

1. The ________________ shows an outline of the title and text of each slide in the presentation.

2. The ________________ shows the current slide.

3. The ________________ is a region of a slide reserved for inserting text.

4. The ________________ shows a column of numbered slide thumbnails so you can see a visual representation of several slides at once.
5. Pressing the TAB key in front of bulleted text will ____________________.

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.

---

**Summary**

You now have come to the end of Lesson 4. In this lesson you have learned the importance of doing an outline for a presentation, and created your own presentation by using an outline.

---

**NOW DO PRACTICAL EXERCISE 4 ON THE NEXT PAGE.**
Practical Exercise:  4

A. This is a hands-on practical exercise. You must have a working computer that has PowerPoint application installed. In this practical exercise you will create a five slide PowerPoint presentation in outline method. The subject of the Presentation will be given to you. It includes all the text and the corresponding slide numbers were they should be located. Do not forget to save your file under the filename “PP Practical 1.”

Slide 1:
Title: PAPUA NEW GUINEA
Subtitle: REFORMING THE PUBLIC SECTOR (press Enter)
PRESENTATION TO THE MANAGEMENT AND STAFF OF THE BURNET INSTITUTE BY BILL KUA

Slide 2:
Title: Purpose of Presentation
Text (take note of the bullet points):
- To provide an overview of the approach taken to public sector reform in PNG
- To explain how public sector reform underpins PNG economic and development goals.
- To outline the initiatives undertaken to date by the Government.

Slide 3:
Title: Introduction
Text (take note of the bullet points):
- PNG gained independence in 1975 (16/9/75).
- The population is about 5.4 million and the people speak over 800 languages.
- Adopted a Westminster style democratic system of government, with the Queen as the Head of State.
- The three (3) arms of government constitute – the Legislature, the Executive and Judiciary.

Slide 4:
Title: Why Reform Is Needed?
Text (take note of the bullet points):
- Rapidly declining capacity in the budget to provide services-we cannot afford the current level of spending.
- Declining capacity to promote development and growth because so little of the budget is available for these purposes.
• Critical budget situation that will deteriorate even further unless there is widespread reform.

Slide 5:
Title: Some Key Public Sector Reform Issues
Text (take note of the bullet points):
• Failures in policy and its implementation.
• Weak coordination across government.
• Failures and weaknesses in provincial and local level government service delivery.
• Poor levels of accountability and continuing concerns about corruption and fraud.
• Red tape constraining business.

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 1.

Answers to Activity 1
1. An **outline** is a **blueprint** or plan of your presentation.
2. The following reasons why it is important to outline a presentation:
   a. It highlights the key logical elements, for example, what points are being made to logically support the core of the message.
   b. It highlights the key structural elements of the presentation such as the introduction, body, conclusion and high-level concepts.
   c. The outline can also map out the transition between elements of your presentation. An outline allows to better structure your ideas.
   d. It allows you to better structure your ideas
   e. It allows you to move the text around your presentation when necessary.
   f. It helps you to quickly develop your presentation.

Answers to Activity 2
1. Slide/Outline tab
2. Slide Pane
3. Place holder
4. Slide/Outlin tab
5. Create a subpoint
Lesson 5: Saving a Presentation

Welcome to Lesson 5 of Unit 3. In Lesson 4, we had a hands-on application in creating our very first presentation using the outline method. We also enumerated the importance of outlining a presentation.

In this lesson, we will learn how to save a presentation. We will be identifying the process on how to save a presentation and enumerate the importance of saving a Presentation in different locations.

Your Aim:
- properly save a Presentation in different locations

Saving a Presentation

Read the following information and be ready to answer the questions that follow.

Saving your PowerPoint presentation is very important. After you create a new presentation, always save it. And save your presentation from time to time as you work on it as well. Until you save your work, it stays in the computer's (RAM) memory which is an unsafe location. If a power blackout occurs or your computer freezes, you lose all the work you did since the last time you saved your presentation. Make it a practice to save files every ten minutes or so or when you complete an important task.

**RAM** refers to the parts of a computer that keep hold of data for some period of time, possibly even after the computer is turned off.

**My Documents** is a folder that stores documents, program settings, and other files. For example, when saving a file in PowerPoint, the standard folder will often be **My Documents**. Saving all your personal files into the My Documents folder makes backing up and locating your personal files easier.

In Lesson 4, you saved the presentation that you created in **My Documents** folder. We will have a revision of that, then you will learn how to save a presentation in other folders. But, before you do so, you will first create a three slide presentation, that you will use to practice saving with. Let us now begin.

1. First, open PowerPoint application on your computer. The first time you open PowerPoint, a new blank presentation is opened. You can see it on the slides pane.

2. In the Slide pane, type this title: **The Provinces of Papua New Guinea** to the **Click to Add Title** placeholder. (Please take note, that text appears in bold in this lesson to stress the text you are to type on your slides, but the texts should all be written in normal font on your slides).
3. In the Outline/Slides pane, click the Outline tab. You will notice that the text you just typed also appears there.

4. In the Slide pane, click on to the “Click to add Subtitle placeholder.”

   The title placeholder is deselected, and the subtitle placeholder is selected. Type the following **Papua New Guinea is Malay for frizzled, referring to Native’s hair. The island New Guinea was named by Ortiz de Rez, from the native’s resemblance to those of Guinea in Africa**, and then press ENTER to move the insertion point to a new line in the same placeholder.

5. In this step you will first save your work before you proceed with your Presentation. Follow the sequence of letters for instructions of saving our PowerPoint Presentation on the My Documents folder.

   a. On the menu bar, put your mouse over the File Menu, and left click.

   b. On the drop down menu click save, the images below will show you how to do it correctly.

   c. On the Save As screen, go down to the filename box and type **The Provinces of PNG**, look at the **Save in:** which is located at the top. This shows you on which folder you will save your work, as a default the **Save in:** contains My Documents, remember the folder name, so the next time you open your computer you would know where to look for your file. Look at the image on the next page and compare your screen to it. They should be similar with the picture on the next page.
5. Put your mouse pointer over the Slide/Outline pane and right-click. A pop-up menu will open. From the pop-up menu select New Slide.

6. Without clicking anywhere, type **Papua New Guinea is Divided into Twenty Two Provinces.**

7. On the Outline tab, click to the right of Provinces, and then press ENTER from the keyboard. PowerPoint adds a new slide to the presentation, and an icon for Slide 3 appears in the Outline pane.

8. Press the TAB key on the keyboard.

The Slide 3 icon changes to a bullet on Slide 2. The bullet is gray until you enter text for the bullet point.

9. Now type this text after the bullet: **Bougainville**, press ENTER from the keyboard and the next bullet will appear, type **Central** press ENTER, type **Chimbu** press enter, type **Eastern Highlands** press ENTER, type **East New Britain** press ENTER, type **East Sepik** press ENTER, type **Enga** press ENTER, type **Gulf** press ENTER, type **Hela** press ENTER, type **Jiwaka** press ENTER, type **Madang**.

Refer to the image on the next page to see if you have done it right.
10. Press SHIFT+TAB (This is a special key). To do this press and hold down the SHIFT key and the TAB key.

On the outline tab, the bullet changes into an icon for Slide 3. The new slide is displayed in the Slide pane.

11. Type **Continuation of PNG provinces**, press ENTER, and then press TAB.

13. Put your mouse pointer over the File menu tab and click it. On the drop down menu click Save. Since we have already saved this document before, you were not asked to provide a filename again. All it did was update the file by saving the changes you made.

---

**Activity 1:** Write a brief explanation on the question given.

1. Explain why we should save our PowerPoint Presentation document every 10 minutes or as frequently as possible?

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.

---

**Saving a Presentation**

We have done a good job on that revision topic. Now we will try to open the Provinces of PNG Power Point Presentation (.pptx) file and save it in another location or folder.

---

The file extension for a PowerPoint Presentation is .pptx. A .pptx file can only be opened in a PowerPoint application software.

**File extension** is the suffix (separated from filename by a dot), which shows what kind of file it is. Example, .docx (Microsoft Word document), .xlsx (Microsoft Excel document)

When you attempt to save a presentation for the first time in the Save As dialog box, PowerPoint shows you the contents of the My Documents folder. In this next exercise we will save our presentation to a different folder. Follow the steps in this exercise and never skip any reading.

1. Let us open the Provinces of PNG file, which we have saved earlier on the My Documents folder. You need to open PowerPoint Application. Put your mouse pointer over the File tab and left click it. Move your mouse down to Open and left click it, the Open screen will open. The results of your actions should look like the image on the next page.
2. From the Open dialogue window, direct your attention to the **Look in:**. Check to see if **My Documents** is shown (remember this is the folder where we saved our PNG Provinces document). If you have the same image as the one below, then you should see your **Provinces of PNG.pptx** file. Double click on it, or left click on it and press the **open** button.
If **My Document** is not beside the **Look in:** box just click on the **My Documents** folder found on the left side of the Open dialogue window.

3. Now that you have opened your file, let us save it to a different folder or location, or better yet **into a folder under your name**. With your Provinces of PNG file open, click the **File Menu**, and then click **Save As**.

   We click the Save As command instead of the Save command, because our existing file has already been saved, what we will do is just to save the same copy in a different location, if this is the action you wish to do, remember it should be the Save As command and not the Save command you should use.
After the Save As command has been clicked the Save As screen would open.

4. In the Save As screen, you should see this setting.
   If not you should change the Save in box to My Documents, go back to Step 3 if you have forgotten how to transfer to a different folder.

5. Our Save As screen should still be open at this time and our Save in should have the My Documents, we will now create a new folder inside the My Documents folder. Observe the image below. Each setting should be the same. Look for the Create New Folder icon. The image below will show you where it is located. Compare it with the one in your screen.

   Once you have found the Create New Folder icon, click on it with your mouse.
6. After you have clicked the Create New Folder icon, a **New Folder Screen** will appear. Put your mouse pointer inside the box. When you start to see the insertion point, **Type your last name**, your last name will be the name of the new folder. Refer to the image below.

7. After clicking Ok, the folder under your name would open. You would see it beside the **Save in:** just like this image.

8. On the Save As screen, check that the filename is **Provinces of PNG.pptx**, and then press the Save button.

Now we have the Provinces of PNG.ppt file in the **My documents** folder and the same file inside the folder under your name.

---

**Activity 1:** Write a brief explanation on the question given.

1. How is —**Save**— command different from —**Save As**— command?

---

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.

---

**Summary**

You now have come to the end of Lesson 5. In this lesson we did a revision of saving the file in the My Documents folder, we have also learned how to Save a file on a different location or folder, we have also stated the importance of constantly saving a file.

---

**NOW DO PRACTICAL EXERCISE 5 ON THE NEXT PAGE.**
Practical Exercise: 5

A. Circle the letter of the best answer.

1. What is the file extension used for PowerPoint Presentation file.
   
   A. Exe  
   B. Pptx  
   C. Pot  
   D. Pos

2. How often must you save your PowerPoint Presentation file?
   
   A. Every 10 minutes  
   B. Every 5 minutes  
   C. Every 2 minutes  
   D. As often as possible

3. How do you save two versions of the same file?
   
   A. Save and Save in  
   B. Save in and Save as  
   C. Save and Save as  
   D. None of the above

4. What is the name of the standard folder where PowerPoint Presentation files can be saved?
   
   A. Last Name Folder  
   B. Your Documents Folder  
   C. My Documents Folder  
   D. Our Documents Folder

5. Which of the following icons represents that of a folder?

   A.  
   B.  
   C.  
   D.  

1. If you are saving your PowerPoint presentation for the first time what command must you use?

   A. File Menu
B. Save
C. Save as
D. Save in

2. A file with a file extension of .pptx can be opened with __________ application.
   A. Excel
   B. Word
   C. PowerPoint
   D. Publisher

3. You can create a new folder by clicking the ___________________ icon.
   A. Save
   B. Folder
   C. Save in
   D. New folder

4. If a file is not saved, it is usually stored in what memory?
   A. ROM
   B. RAM
   C. My Documents
   D. REM

10. Under which menu tab can we find the ―Save as‖ command?
    A. Save Tab
    B. Insert Tab
    C. Review Tab
    D. File Tab

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 1.

Answers to Activity 1

1. We need to save our file every 10 minutes or more often so that in cases of blackout or computer freezes. We are sure that when our computer comes back to normal our files are not loss and can still be found on the folders where we have saved them.

Answers to Activity 2

1. Save command is used if the file is being saved for the first time. Save As is used if a saved file is to be saved in a different location or folder.
Lesson 6: Viewing a Presentation

Welcome to Lesson 6 of Unit 3. In Lesson 5, we learned the importance of saving our document. We also learnt how to save the same document on different locations so we were able to differentiate —Save” from —Save As”.

In this lesson, we will learn and identify the steps of how to view a Presentation using steps and describe the importance of using the view menu to run a slide show a Presentation.

Your Aim:
- use view menu to slide show a Presentation

Working with Presentation from Different Views

This will be another hands-on lesson. Make sure that you have your working computers and PowerPoint presentation open. Read through the entire lesson and do not skip anything.

When putting a presentation together, it can be helpful to work with your presentation from different views. For example, if you want to edit the content of your slide, you would want to use the Normal view. You can access most of the available views from the View menu tab.

The views in Microsoft PowerPoint 2010 that you can use to edit, print, and deliver your presentation are, Normal view, Slide Sorter view, Notes Page view, Slide Show view (which includes Presenter view), Reading view, Master views: Slide, Handout, and Notes.

As the screen capture below shows, you can find PowerPoint views in two places:
- On the View tab, in the Presentations Views and Master Views groups.
- On an easy to use bar at the bottom of the PowerPoint Window where the main views (Normal, Slide Sorter, Reading, and Slide Show) are available.
Views for Editing your presentation:

**Normal View**
Normal view is the main editing view, where you write and design your presentations.

**Slide Sorter View**
Slide Sorter view gives you a view of your slides in thumbnail form. This view makes it easy for you to sort and organize the sequence of your slides as you create your presentation, and then also as you prepare your presentation for printing.

**Notes Page View**
The Notes pane is located under the Slide pane. You can type notes that apply to the current slide. Later, you can print your notes and refer to them when you give your presentation. You can also print notes to give to your audience or include the notes in a presentation that you send to the audience or post on a Web page.

**View tab** is a part of the Microsoft 2010 Ribbon bar.

Views for delivering your presentation

**Slide Show View**
Use Slide Show view to deliver your presentation to your audience. Slide Show view occupies the full computer screen, exactly the way your presentation will look on a big screen when your audience sees it.

**Reading View**
Use reading view to deliver your presentation not to an audience (via a large screen, for example), but instead to someone viewing your presentation on their own computer.

---

**Activity 1:** Select the best answer from the choices given. Encircle the letter of your answer.

1. Which of the following is not one of PowerPoint's view?
   A. Outline View
   B. Slide view
   C. Slide Show View
D. Presentation View

2. The view that displays the slides in a thumbnail form is called
A. Outline View
B. Slide Show
C. Notes page view
D. Slide Sorter View

3. The view that displays your presentation to the person viewing your presentation on the computer
A. Reading View
B. Slide Show View
C. Notes Page View
D. Slide Sorter View

4. Notes page view is available here.
A. View Tab
B. Home Tab
C. Review Tab
D. Transitions Tab

5. In order to see all the slides on one screen in Microsoft PowerPoint use __________.
A. View, slide
B. View, master
C. View, slide show
D. View, slide sorter

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answer. Make sure you do the necessary corrections before moving on to the next part of this lesson.

How to use the Different Views
Let us now practice using the different views we have discussed. This is a hands on exercise and be sure you have a Computer with PowerPoint installed. Go ahead and do the exercise now.

1. Start PowerPoint, click File, and New, click "Blank Presentation". A list of options will open, click the "Sample Templates" as shown on the next page.
2. After clicking the Sample Templates, a new window will open showing the templates. Select **Project Status Report** by clicking it. Then click the **Create** button found on the right side of the PowerPoint window.

3. **The Normal View** is displayed by default. If you click the **Slide Sorter View** button. Several slides of your presentation will be shown on your screen at once. Refer to the image below.
4. Select the **View tab**, then click the **Notes Page**. Note that the slide now is shown on the top of the window, with an area for notes at the bottom.

5. Click on the **Slide Show** button, 📀. The presentation slide show starts, with the current slide in view.

6. To move to the next slide, click the mouse button. Everytime you click the mouse, each page is shown in turn on the slideshow. Continue to the end or press <Esc>.

   Esc is found on left side of your keyboard on the top corner. Use this everytime you want to end a presentation to finish.

7. Make sure you are in **Normal View** 📖, and then click on the **Slides** tab. A list of slide reduced in size is displayed on the left side with the current slide (as shown in the **Slide pane**) highlighted. Refer to the image on the next page.
8. Each pane works independently of the others, although they are linked. Click slide 4 on the Slides list and slide 4 will be shown on the Slide pane.

9. From the ribbon, select View then click Zoom and choose 100% from the Zoom dialog box. Click OK.

10. You can use the scroll bar at the bottom of the Slide pane window to see more of your slide.

11. Now click Fit to Window from the View tab. The slide returns to its dimensions when PowerPoint was originally opened.

12. Select the Outline tab, to view the contents of the slides in the left pane. Each slide is represented by a small icon and the slide number,  

13. Use the scroll bar on the right of the pane to display slide 10. Move the mouse over the icon for slide 10 until it becomes . Click once to display slide 10 in the Slide pane. The associated text and icon are highlighted in the Outline pane.
14. Move the mouse over the border on the right of the Outline pane until it becomes ▶. Click, hold down and drag to change the size of the pane until it fills about half the screen. Drag to the left to decrease the size of the pane or to the right to increase it. Drag the border back to its original position.

15. View slide 4, Issues and Resolutions. Click in the Notes pane (notes pane is found at the bottom of each slide) and type in Sales Director to give brief report on our competitors.

Activity 2: Write a brief explanation.

1. How is using different views helpful to the user when creating a PowerPoint presentation?
   _____________________________________________________________________
   _____________________________________________________________________
   _____________________________________________________________________

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Summary
You have come to the end of Lesson 6. In this lesson we have discussed the different views, and why it is important to apply different views in a presentation. We also put into practical application the layout of different views.
Practical Exercise: 6

A. This is a hands-on practical exercise. You must have a working computer that has PowerPoint application installed. In this practical exercise you will create a four slide PowerPoint presentation. The subject of the Presentation will be given to you that includes all the contents and the corresponding slide number they should be located. Follow the instructions given after typing the content of the Presentation.

Slide 1: Title: From Cocoa Beans to Choc Bars  
Subtitle: (From an article of the "Paradise Magazine")

Slide 2: Content: For over 100 years, cocoa has been the driving force behind commercial agriculture in PNG. Until now, there has been little local use of PNG cocoa. Instead large quantities of this home-grown hero have been exported to overseas market.

Slide 3: Content: In 2011, Paradise Foods Limited embarked on a new and exciting project, investing in the establishment of a pilot plant to process cocoa beans grown from the rich soils of Papua New Guinea into single origin chocolate couverture.

Slide 4: Content: By making chocolate out of blended cocoa beans from different regions, we are aiming to develop our own quality chocolate, something that is purely PNG and truly unique.

After completing the powerpoint, perform the following tasks:

1. View the notes page for the first slide.
2. Use the zoom control to change the magnification of the page to 75%.
3. Insert the following text into the notes page area.

   As one of PNG’s most resourceful companies, Paradise Foods is committed to developing and producing high quality food products.

4. Use the zoom control to display the whole page.
5. Change to Slide Sorter View and select slide two (2).
6. Switch to Notes Page View and insert the following text:

   Managing Director David Peate is proud of the development of the Port Moresby pilot plant.

7. Make sure the option is set to end the presentation with a black end slide. Switch to slide show view.
8. View the whole show.
9. Save the presentation as “PP Practical 2”.
10. Close the presentation.

---

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 1.

Answers to Activity 1

1. C
2. B
3. D
4. C
5. A

Answers to Activity 2

1. Using different views in Powerpoint helps in different ways. For creating or editing your presentation. You can use the Normal view, Slide Sorter view, Notes Page view, and Master view. In delivering your presentation you can use the Slide Show view, and Presenter view. To prepare and print your presentation you can use the Slide Sorter view, and the Print view.
Answers to Practical Exercises

Practice Exercise 1

1. Outline/Slides Pane
2. Planning
3. PowerPoint
4. Start Button
5. Slide
6. Presenter
7. Title Bar
8. Microsoft Office
9. Task Pane
10. Drawing Toolbar

Practical Exercise 2
(Possible answers only, answers vary on the students imagination)

During the last period at school, our teacher gave us some reminders before sending us home

I rode the school bus, so it will be safer to travel

I reached our house just in time for dinner

Practice Exercise 3

1. Chevron
2. Pop-up
3. Customise
4. Menu/s
5. Chevron
Practical Exercise 4

1. Papua New Guinea
   Reforming the Public Sector
   Presentation to the Management and Staff
   of the Burnet Institute by Bill Kua

2. Purpose of Presentation
   - To provide an overview of the approach taken to public sector reform in PNG
   - To explain how public sector reform underpins PNG economic and development goals.
   - To outline the initiatives undertaken to date by the Government.

3. Introduction
   - PNG gained independence in 1975 (16/9/75).
   - The population is about 5.4 million and the people speak over 800 languages.
   - Adopted a Westminster style democratic system of government, with the Queen as the Head of State.
   - The three (3) arms of government constitute – the Legislature, the Executive and Judiciary.

4. Why Reform Is Needed
   - Rapidly declining capacity in the budget to provide services—we cannot afford the current level of spending.
   - Declining capacity to promote development and growth because so little of the budget is available for these purposes.
   - Critical budget situation that will deteriorate even further unless there is widespread reform.

5. Some Key Public Sector Reform Issues
   - Failures in policy and its implementation.
   - Weak coordination across government.
   - Failures and weaknesses in provincial and local level government service delivery.
   - Poor levels of accountability and continuing concerns about corruption and fraud.
   - Red tape constraining business.

Practice Exercise 5

1. B
2. D
3. C
4. C
5. D
6. B
7. C
8. D
9. B
10. A
Practical Exercise 6

Slide 1
From Cocoa Beans to Choc Bars
(From an article of the "Paradise Magazine")

Slide 2
• For over 100 years, cocoa has been the driving force behind commercial agriculture in PNG. Until now, there has been little local use of PNG cocoa, instead large quantities of this home-grown hero have been exported to overseas market.

Slide 3
Click to add title
• In 2011, Paradise Foods Limited embarked on a new and exciting project, investing in the establishment of a pilot plant to process cocoa beans grown from the rich soils of Papua New Guineas into single origin chocolate couverture.

Slide 4
Click to add title
• By making chocolate out of blended cocoa beans from different regions, we are aiming to develop our own quality chocolate, something that is purely PNG and truly unique.

End of Topic 1.

Now Do Exercise 1 in Assignment Book 1 Then Go to Topic 2.
TOPIC 2

ADDING BASICS TO PRESENTATION

Lesson 7: Adding a Design Template
Lesson 8: Customising the Background of a Presentation
Lesson 9: Inserting Graphics, Clip Art, and/or Digital Pictures to a Presentation
Lesson 10: Using Word Art in a Presentation
Lesson 11: Adding Graphics from the Internet
Lesson 12: Adding Animation Schemes
TOPIC 2: ADDING BASICS TO PRESENTATION

In this topic you will learn the basic concepts of PowerPoint. The Topic is designed to help yourself with the terminologies and icons used in PowerPoint. It aims for you to gain basic understanding of adding basic design and artistic effect to a presentation.

In the previous topic you have studied the basics of creating a presentation. In this topic you will be studying how to add basic design and animation.

In this topic, you will study about the following:

**Lesson 7** is all about Adding a Design Template. You will be introduced on how to put a design to your slide using predefined templates.

**Lesson 8** is all about Customising the Background of a Presentation. You will be learn how to customise the design of your background.

**Lesson 9** is all about Inserting Graphics, Clip Art, and/or Digital Pictures to a presentation. You will be introduced to adding images to enhance your presentation.

**Lesson 10** is all about Using Word Art in a Presentation. You will learn how to create art with the texts in your presentation.

**Lesson 11** is all about Adding Graphics from the Internet. You will be introduced to adding images to a presentation by the use of the internet.

**Lesson 12** is all about Adding Animation Schemes. This is the lesson that will teach you how to animate the texts in your presentation.
Lesson 7: Adding a Design Template

Welcome to Lesson 7 of Unit 3. In Lesson 6, we learned the importance of using different views in PowerPoint. We also learnt how to switch from one view to another. Depending on what we want to do with our presentation we can change our Presentation view to achieve this.

In this lesson, we will learn how to name the different types of design template, identify menu for adding a design template, use appropriate design template for a presentation, and show the importance of using appropriate design template for different presentation types.

Your Aims:
- identify different types of design template
- use the appropriate design template for a presentation

Design Template

What is a Design Template? A Design Template refers to the specific "look" of a slide or group of slides. A design template can be very basic - with black text on a white background - or it can be very colourful and detailed. Normally, PowerPoint presentations have the same design templates for all slides, while it is possible to select a different design template for each slide. To be consistent, it is good to use the same design throughout a single presentation.

Microsoft PowerPoint provides design templates and other different types of templates that you can apply to a presentation to give a fully designed professional look. Let us look at the different types of templates available in PowerPoint.

- **Power Point Design Template**
  Using the Design tab you can preview and apply a design template to your presentation. The template can be applied to all slides or selected slides, and you can apply more than one type of design template in a single presentation.

- **Content Template**
  A content template has all the elements of a design template plus a suggested outline for the presentation. You apply a content template when you first create a presentation.

- **Templates from the Web sites**
  If you are connected to the internet, you can check out templates from different web sites, this offers variety of templates to choose from.
- **Templates on Microsoft.com**
  Choose from additional PowerPoint templates available from Microsoft Office Online in the Templates area of Microsoft Template Gallery. The templates are arranged according to type of presentation.

  **Activity 1:** Write a brief explanation on the question given.

  1. Compare and contrast the templates from the Web sites and Templates at Microsoft.com.

  ____________________________________________

  ____________________________________________

  ____________________________________________

  ____________________________________________

  Thank you for completing this activity. Now, you may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.

**Choosing the Right Template**

PowerPoint 2010 contains different professional ready-made design templates from which to choose. However, these templates have different features and choosing the right template is important to the success of a presentation. Templates add images to a presentation. The following guidelines can help you choose a presentation that will have an impact on your audience.

- To improve **legibility**, choose a template which allows for high difference between the background colour and the text colour.

- Avoid templates with bright-coloured backgrounds because these can be hard on the eye and affect **legibility**.

  **Legibility** is the level to which individual characters in text are understandable or recognizable based on appearance. The surround can affect the legibility of text.

- If the presentation will be done in a darkened room, consider using a lighter background colour. Glow from lights are more obvious on darker backgrounds.

- The focus of a presentation should be the contents of the slide, not the surrounding graphic design. Avoid distracting the audience with an over-the-top presentation design but instead use a simple but attractive presentation design.
Select a template that matches the mood you are trying to communicate. If the
graphic design of a template is badly chosen to the content of the presentation, not
only could it be less appealing to your audience, but it may even distract them.

Now in the next part of the lesson, we will describe how to use Design Templates to change
the appearance of your slides. It also describes how to insert and manipulate images on
your slide. This is a step by step process. Be sure to have a working computer in front of
you. Open Microsoft PowerPoint and let’s start the lesson. Make sure that you have opened
a blank presentation using the PowerPoint program.

To change the design template:

1. Go to Design Tab, under the Themes group. You will see different design templates.

2. Move your mouse pointer over the theme you would like to apply to your
presentation. You would see that the preview for the design will automatically be
viewed on the open slide. To apply on theme, click on it.

Note: If you wish to apply the theme to a selected slide only, right click on your selected
theme and on the pop up menu select "Apply to Selected Slides."

Activity 2: Answer the question.

1. Why is legibility important when adding a design template to a PowerPoint
Presentation?

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________
___________________________________________________________________
___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

___________________________________________________________________
Thank you for completing this activity. Now, you may go to the end of this lesson to check your answer. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Summary

You now have come to the end of Lesson 7. In this lesson we have defined template, saw the different types of templates, enumerated the importance of template, and most importantly used template for our PowerPoint Presentation.

NOW DO PRACTICE EXERCISE 7 ON THE NEXT PAGE
Practice Exercise: 7

A. This is a hands-on practical exercise. You must have a working computer that has PowerPoint application installed. In this practical exercise you will create a five-slide PowerPoint presentation. The subject of the Presentation will be given to you. It includes all the contents and the corresponding slide number where they should be located. After writing all the contents to the slide, apply the “Texture” design template. Do not forget to save your file under the filename “PP Practical 3.”

Slide 1: Title: The Caves of the Kosua
Subtitle: By Stephen Read & Stephen McCullagh (an article from the Paradise Magazine"

Slide 2: Title: The Location
Content: Our base camp was in the village of Fogomaiyu. This is a small community located on the eastern slopes of the enigmatic Mount Bosavi. It is surrounded by the rainforests of the Upper Kikori in the Southern Highlands.

Slide 3: Title: The Local People
Content: The region is the homeland of the Kosua people who have lived in complete isolation from the outside world until relatively recently. They retain a great deal of their traditional ways and the famous PNG hospitality is on full show.

Slide 4: Title: The Expedition Team
Content: The cavers were six Irish men and one German. An expedition from Australia helped manage access and interactions with the tribe.

Slide 5: Title: The Goal
Content: To be the first people to record, map, explore and discover the caves and underground rivers that riddle the landscape to the east of Mount Bosavi and into the Darai Plateau.

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 2.

Answers to Activity 1

1. Templates from a website and template from Microsoft Office.com both need internet connection before they can be used. However, templates from the website are done by other people while templates from Microsoft Office.com are done by the Microsoft company, who own the software-MS Office of which PowerPoint is a part of.
Answers to Activity 2

1. Legibility should be maintained when adding design template because, the content should be readable to the audience, design template comes second in priority when doing a PowerPoint presentation.
Lesson 8: Customising the Background of a Presentation

Welcome to Lesson 8 of Unit 3. In Lesson 7, we learned about the different types of design template, identified menu for adding a design template, used appropriate design template for a presentation, and explained the importance of using appropriate design template for presentation.

In this lesson, we will learn how to name and differentiate the different backgrounds available and customise them.

**Your Aims:**
- identify and define the different backgrounds available for presentation
- use the appropriate background type for a presentation

Changing the background of a presentation

Apart from using themes, you can change the background colour or background design on slides and notes. Changing the background is useful if you just want a simple shade or texture for a slide background and not all the other design elements in a design template. Otherwise you might want to change the background to highlight sections of a presentation. Besides changing the colour, you can add shading, a pattern, a texture, or a picture.

When you change the slide background, you can apply the change to a single slide or all slides.

There are different backgrounds types available for use in a presentation including but not limited to the following:

- **Colour from the Colour Scheme**
  A colour scheme consists of the eight colours used in the design of the slide-colours for background, text and lines, shadows, title text, fills, accents, and hyperlinks. A presentation's colour scheme is determined by the design template that is applied.

- **Colour outside the Colour Scheme**
  If you introduce new colours to the presentation that are not part of the colour scheme say, by changing the colour of a font in one place or making one object a unique colour, the new colour is added to all colour menus, and appears below the eight colours of the colour scheme.

- **Background Fill from the Slide master**
  The slide master is an element of the design template that stores information about the template. It includes font styles, placeholder sizes and positions, background design, and colour schemes.
The purpose of the slide master is to let you make a global change such as replacing the font style and have that change reflected on all the slides in your presentation.

You would normally go to the slide master to do any of the following:

- Change the font or bullets
- Insert art, such as a logo, that you want to appear on multiple slides
- Change placeholder positions, size, and formatting

To change view from Slide to Slide Master do the following steps:

1. Click **View Tab**.
2. Select the **Slide Master**.
3. To go back to slide view, Click **Close Master View**, from the Slide Master View tab.
Activity 1: Write a brief explanation on the question given. You may go back to Lesson 7 to help answer this question.

1. How are the Design Templates different from background design?

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________
___________________________
________________________________________
___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Customizing the background
On this part of the lesson we will put into use the different background designs that we talked about. This exercise is also known as customizing the background, since we are going to add our own background preference rather than use ready-made ones.

Customise/customizing the background means to make or change the background to individual or personal settings. This is a hands-on exercise, be sure your computer is on and PowerPoint application is open, do not skip any of the following steps.

Adding Colour from the Colour Scheme into the background

The image on the right is an exact example of a Colour Scheme, the parts of a Colour Scheme is labeled according to the following:

1. Colours used for title text and body text
2. Colour used for background, fills, and shadows
3. Colours used for hyperlinks, fills, and accents such as bullets

Let us try to apply our very first colour scheme into a Presentation.

1. Open a Single Slide PowerPoint.
2. On the ribbon bar select the **Design Menu Tab**, on the far right end select the **Background Styles** (under the Background Group). Select a background style of your choice.

3. Under the themes group (still under the Design tab), click on colours for colour scheme

4. Keep the file open for the next exercise.

**Colour outside the Colour Scheme**

If you introduce new colours to the presentation that are not part of the colour scheme the new colour is added to all colour menus, and appears below the eight colours of the colour scheme.

1. Select Colours under the Themes group.
2. Click the Create New Theme Colours
Let us try to apply colour outside the Colour Scheme. Do the following steps:

1. We will use the same presentation that we have used above with the Colour Scheme of your choice applied.

2. On the Title type the word --Hello--.

3. Depending on the Scheme that you have selected, the word --Hello" will reflect the colour of the scheme you choose.

4. Select **Create New Theme Colours**... and a window similar to the one below will appear.

5. Select the box beside Text/Background – Dark 1.

6. Select a colour that you want to use then name the scheme by typing a name on the box beside the **name**: click save.

In the above exercise, we changed one of the twelve colours of the colour scheme. The change that we have done will be visible if you type a text on a light coloured background.
Remember the following tips in choosing colours as a background for a presentation:

1. Choose colours that are easily visible when viewed on a monitor or projected onto a screen in a bright room.
2. Colours that are opposite (different shade, same saturation level)
3. Colours that contrast well.
4. At least one bright, saturated colour (useful for highlights)
5. Black or white, if you haven’t used them or their equivalents in the first two colour blocks.
6. A medium-tone neutral (gray, for example)

Saturated/Saturation is the intensity of a colour, expressed as the degree to which it differs from white. A saturated image has overly bright colours.

**Activity 2:** This is a hands-on practical exercise, you must have a working computer that has PowerPoint application installed. In this practical exercise you will The subject of the Presentation will be given to you. That includes all the contents and the corresponding slide numbers where they should be located. After writing all the contents to the slide, follow the rest of the instructions given. Do not forget to

1. Create a five-slide PowerPoint presentation.

2. Type the following contents to its corresponding slides:

   **Slide 1:** Title: O Arise, All You Sons
   Subtitle: Lyrics and Music: Thomas Shacklady

   **Slide 2:** Content: O arise all you sons of this land,
   Let us sing of our joy to be free,
   Praising God and Rejoicing to be
   Papua New Guinea

   **Slide 3:** Content: Shout our name from the mountais to seas
   Papua New Guinea
   Let us raise our voices and proclaim
   Papua New Guinea

   **Slide 4:** Content: Now give thanks to the good Lord above
   For His kindness, His wisdom and love
   For this land of our fathers so free,
   Papua New Guinea

   **Slide 5:** Content: Shout again for the whole world to hear
   Papua New Guinea;
   We’re independent and we’re free
   Papua New Guinea
3. Go to the first slide and apply the first colour scheme (Office) found on Colours.

4. Go to the second slide and apply Style number 7 from the background styles. Apply the fill effect to the second slide only

5. Go to the third slide and apply Austin theme effect. Apply it to the third slide only.

6. Go to the fourth slide and apply Angles theme effect. Apply it to the fourth slide only.

7. Go to the fifth slide and apply Couture theme effect. Apply it to the fifth slide only.

8. Save your file under the filename — PP Practical 4.”

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answer. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Summary
You now have come to the end of Lesson 8. In this lesson we have defined templates and backgrounds, saw the different types of templates and backgrounds, enumerate the importance of templates and backgrounds, and most importantly used the appropriate design templates and backgrounds for our PowerPoint Presentation.

NOW DO PRACTICE EXERCISE 8 ON THE NEXT PAGE
A. Select your answer from the choices given. Circle the letter of the correct answer.

1. After choosing a predefined template, which option has to be chosen to change the background colour?
   A. Design Template  B. Colour Scheme
   C. Animation Scheme  D. Colour Effect

2. Which PowerPoint feature adds special effects to modify the appearance of the slides?
   A. Colour Scheme  B. Animation
   C. Transition Settings  D. Handouts

3. Which of the following is not correct regarding the Background of slides
   A. Background colour of slides can be change
   B. Picture can be set as Slide Background
   C. Texture can be set as Slide Background
   D. Background colour is only applicable to one slide

4. After choosing a predefined template, __________ option has to be chosen to change a background colour
   A. Design Template  B. Colour Scheme
   C. Animation Scheme  D. Colour Effects

Refer to the information below to answer question 5:

i. Radient
ii. Texture
iii. Picture

5. According to the given information __________ can be used as slide background.
   A. i only  B. ii only
   C. i and ii only  D. i, ii, and iii

Refer to the information below to answer question 6:
i. creating a Template  
ii. editing the slide master  
iii. using the autocorrect wizard

6. According to the given information, you create a uniform appearance by adding a background image to all slides by:

A. i only  
B. i and ii only  
C. ii and iii only  
D. i, ii and iii

7. Which command will you use in PowerPoint if you need to change the colour of different objects without changing content?

A. Design Template  
B. Colour Scheme  
C. Font Colour  
D. Object Colour

B. Write True if the statement is correct and False if the incorrect on the blank space after each statement.

1. When you change the slide background, you can apply the change to the present slide only. __________

2. Edit Colour Schemes is found at the bottom of the taskpane. __________

3. Colour Scheme consist the seven colours of the rainbow. __________

Answers to Activity 1

1. Design Template can vary from very basic to very colourful and detailed while background design offers simple shade or texture for a slide background and not all the other design elements in a design template.
Answers to Activity 2

O Arise, All You Sons
Lyrics and Music: Thomas Shacklady

O arise all you sons of this land,
Let us sing of our joy to be free,
Praising God and rejoicing to be
Papua New Guinean

Shout our name from the mountains to sea,
Papua New Guinean
Let us raise our voices and proclaim
Papua New Guinean

Now give thanks to the Lord above
For His kindness, His wisdom and love
For the land of our fathers so free,
Papua New Guinean

Shout again for the whole world to hear
Papua New Guinean,
We're independent and we're free
Papua New Guinean
Lesson 9: Inserting Graphics, Clip Art, and/or Digital Pictures to a Presentation

Welcome to Lesson 9 of Unit 3. In Lesson 8, we named and differentiate the different backgrounds available for presentation and learned how to customise the background for presentation.

In this lesson, we will identify the steps in inserting graphics, Clip Art, and/or images. We will also identify how to insert graphics, Clip Art, and pictures in a presentation. Finally you will list down the importance of these activities.

Your Aims:
- identify the process of inserting graphics, Clip Art and/or digital pictures
- correctly insert graphics, Clip Art, and/or digital pictures

Adding graphics to the presentation

Adding images to your presentations makes them more interesting and engaging. Pictures, Clip Art and screenshots can be inserted into PowerPoint to help you effectively communicate your ideas to your audience.

There are two ways to add graphics to your presentation.
- Use the Microsoft Clip Art Gallery, which is a built-in feature.
- Use graphics you have saved on your computer or USB key from other sources.

Use the Microsoft Clip Art Gallery
1. From the ribbon bar, go to Insert Menu tab, under the Images group, click Clip Art as shown in the image below.
2. The Microsoft Clip Art Gallery Window appears on the task pane. Find a picture that you want by browsing or entering a search term in the box.

3. To make a selection do a single click on the image that you want or click on the down arrow to insert the picture into your presentation.
Use graphics you have saved on your computer or USB key
If you want to insert an image from your computer or USB device, the following steps will be useful.

1. From the ribbon bar, go to Insert Tab, under the images group. Click Picture.

2. The Insert Picture dialogue window will open. Choose the location of the image you want to insert (from the computer or USB device) and then double click on the file you want or single click on it and click the insert button.

Activity 1: Write a brief explanation on the question given.

1. Why is it important to add an image to your presentation?
Thank you for completing this activity. Now, you may go to the end of this lesson to check your answer. Make sure you do the necessary corrections before moving on to the next part of this lesson.

**Basic Image Editing**

After inserting image to your presentation there are a lot more things you can do to enhance your image. Here are some of the basic image editing that you can do. Try to follow the steps provided. Do not hesitate to repeat the steps if you get confused along the way.

**To move an image:**

1. Click on the image to select it (white dots, or “resizing handles” will appear around its edges)

2. Place your cursor over the picture. The cursor will turn into a two headed arrow and you can drag the image to where you want it. You can also use the arrow keys on your keyboard to move an image around the slide.

This is when you resize the image when a four (4) pointer arrow is what will show to indicate that you can move the image.
Resizing images
To adjust the size of your image do the following steps:

1. Click on one of the resizing handles at the corner of the image and drag it towards the centre: using the corner handles will reduce the image's size whilst still maintaining its aspect ratio. But do not use the handles at the sides of an image or you will distort it by squashing it. You can use the same approach by dragging the corner handle away from the centre to make the image bigger.

![Image showing how to resize an image](image)

The aspect ratio of an image describes the proportional relationship between its width and its height.

2. To make an image larger, drag one of the resizing handles at the corner of the image outwards. Again, do not use the side handles or you will distort the image by stretching it.

Cropping images
If you want to show only a small part your image, you can do this using the cropping tool from the Picture tools ribbon under the Format Menu tab.

![Image showing cropping tool](image)

Cropping is getting rid of unwanted parts of the image keeping only the part of the image you want in your presentation.

The Picture Toolbar is usually visible if a picture is selected; if not, you can make it visible by selecting it from the Toolbar section of the View menu.

To crop an image, follow these steps:

1. Click on the image you wish to crop.

2. Click on the Crop icon. The crop icon is found on the Picture Tools ribbon (which only appears if there is an image selected), Format Tab, under the Size Group.
Thick black borders will appear around the corners and on the sides of the image.

3. Move your mouse pointer at one of these bars – it will change to a black line and you can then click and drag the bar to the right place.

4. Continue doing this with all the bars until you have your final image – as long as you do not click anywhere outside the image, you will remain in cropping mode.

However, if you clicked outside the image, simply click on image again and select Crop and continue cropping your image.
Activity 2: Practical Application. This is a hands-on practical exercise. You must have a working computer that has PowerPoint application installed. In this practical exercise you will create a single slide PowerPoint presentation. Your goal is to create exactly the same presentation like the one shown below. Do not forget to save your file under the filename “PP Practical 4”.

Note: If the images used above are not available from your Clip Art gallery you are allowed to use different images with the consent from your tutor.

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answer. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Summary
You now have come to the end of Lesson 9. In this lesson we have learned the importance of inserting image to our presentation. We have also learned how to insert image to our presentation and lastly learned a little editing of image.

NOW DO PRACTICE EXERCISE 9 ON THE NEXT PAGE
Practice Exercise:  9

A. Select your answer from the choices given. Encircle the letter of your answer.

1. From which tab can you access Picture, Text Box, Chart and others?
   A. File
   B. Design
   C. Insert
   D. View

2. What are the four options available in Images group?
   A. Clipart, Pictures, Shapes, Video
   B. Clipart, From Files, Shapes, Text Box
   C. Clipart, Screen Shots, Photo Album, Picture
   D. Clipart, Pictures, AutoShape, Screen Shots

3. If you select Insert >> Picture
   A. You can insert Pictures and Cliparts
   B. You can insert Cliparts only
   C. You can insert Pictures only
   D. You can insert Font

4. The Microsoft Clip gallery allows you to:
   A. add slides to a presentation.
   B. spell check your presentation.
   C. add word art images to a slide.
   D. add Clip Art images to a slide or slides.

5. When an image is selected, it displays which of the following:
   A. Six boxes
   B. Six middle handles
   C. Two corner handles
   D. Eight sizing handles

6. The collection of ready-to-use images included with Microsoft Office is known as _________.

A. Clip Art    B. Word Art
C. Smart Art    D. Autoshapes

7. Removing unwanted portions of picture is called ______
   A. trimming.    B. cutting.
   C. filtering.    D. cropping.

8. What does “image from a file” mean?
   A. Picture on the internet
   B. Movie clip you saved to your computers memory
   C. Picture you saved to your computers memory
   D. Picture that Microsoft PowerPoint has saved for you

B. Write True if the statement is correct and False if the incorrect on the blank space after each statement.

1. On searching for Clip Art in the Clip Art task pane, an enlarged image of the Clip Art is displayed in the Result Box. __________

2. Clicking the Insert Picture button and selecting a picture will insert the image in a presentation. __________

Answers to Activity 1

1. Adding images to your presentations makes them more interesting and engaging and adds more excitement to your presentation by inserting graphics, clipart and/or digital pictures

Answers to Activity 2

1. Note: If the student has copied exactly the image provided, then the student is said to have succeeded this activity.
Lesson 10: Using WordArt in a Presentation

Welcome to Lesson 10 of Unit 3. In Lesson 9, we identified the steps in inserting graphics, Clip Art, and/or pictures. We also identified menu for inserting graphics, Clip Art, and/or digital pictures and insert graphics Clip Art, and/or digital pictures in a presentation. Finally, we have listed down the importance of inserting graphics, Clip Art, and/or digital pictures.

In this lesson, we will identify the steps to insert a Word Art in a Presentation, identify menu for Word Art, use Word Art in a Presentation and identify the importance of using Word Art in a Presentation.

Your Aims:
- determine how to insert a word art to a presentation
- edit word art
- use appropriate word art style

In today's lesson we will look at WordArt, what it is, what it can do to your presentation. Then you will learn how to put it into your presentation.

Parts of this lesson involves hands on practice. Be sure to have a working computer in front of you with PowerPoint installed on it.

WordArt is a tool that gives you some dramatic, pre-designed styles for formatting your text. Once you select a style and enter your text in the WordArt dialogue box, your text is added to your slide. You can manipulate that WordArt object as you would an image or text box.

In PowerPoint you can add unusual text formats – for example, curved, slanted, or three-dimensional text. To do insert WordArt, follow these steps:

1. On the Insert tab, point to Picture, and then click WordArt.
2. Click Word Art icon.
3. Select a Word Art option here.

1. Click the Insert Tab.

Your Aims:
- determine how to insert a word art to a presentation
- edit word art
- use appropriate word art style
2. Click on the style you want to insert. A text box appears with the text “Your text here”, with the WordArt style you selected applied to it.

3. Edit the text to what you want it to be.

At this point, you will see a Drawing Tools **Format** context tab. Here you will find the **WordArt Styles** group.

This contains the preset styles gallery, and drop downs for controlling the **Text Fill**, **Text Outline**, and (most fun) **Text Effects**.

**Text Fill** – adds color, gradient (blending of shades from light to dark or from one color to another), and/or picture inside a text.

**Text Outline** – adds a line marking in the outer curve or boundary of a text.

**Text Effect** – adds shadow, reflection, or glow to a text. It also can change the direction of a text.
Whenever a WordArt object is selected, the WordArt Format Tab appears.

Activity 1:  This is a hands-on practical exercise, you must have a working computer that has PowerPoint application installed. In this practical exercise you will create a single slide PowerPoint presentation. Your goal is to create exactly the same presentation like the one shown below. Do not forget to save your file under the filename “PP Practical 5.”

Font: Calibri
Size: 54
Text Fill Color: Black
Shape Effect: Reflection, Half Reflection

**Papua New Guinea**

37th Year of Independence

Font: Calibri
Size: 66
Text Fill Color: Gradient, Linear Down
Shape Effect: 3D Rotation, Perspective Relaxed

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Now that you have added WordArt to your presentation. We will do a quick editing. In this part of the lesson, we will be discussing the different types of editing a WordArt. We will do a hands on exercise of each editing procedure. Read through the text and follow all the steps. If you get confused do not hesitate to repeat until you get it right.
Editing WordArt

After creating your WordArt, you can change its colour and style to make it even more appealing. The following are some of the ways you can edit with WordArt:

- Adjusting WordArt Colours
- Adjusting Fill Colour
- Editing WordArt Text
- Changing WordArt Font Face and Size

Let us now take a closer look at each of the editing options. This part of the lesson also includes a step by step process. Be sure to follow and never skip a step. If you get confused along the way, never hesitate to repeat it until you get it right.

Adjusting WordArt Colours

Fill colour and line colour may be adjusted in WordArt. Fill colour is the colour of the letters, and line colour is the colour on the border of the WordArt.

Adjusting Fill Colour

Here is another way of changing the colour of WordArt. Follow these steps to adjust the fill colour of your WordArt:

1. Open a new PowerPoint. On the first slide delete the "Click to Add Title" text box by clicking on the box and pressing delete on the keyboard. Do the same thing for the "Click to add Subtitle".

2. On the Insert Menu Tab, Click WordArt.
3. Select a style in the WordArt Gallery.

4. On the Edit WordArt Text, type your name (your name will be our example throughout the hands-on exercise).

5. Select the WordArt icon by double clicking on it (in this case your name) and the WordArt toolbar will appear.

6. Select the Shape Fill command. For more option with colours, click down the arrow button beside the Shape fill to show the colour palette and select a colour of your choice.

7. Leave your work open for the next exercise.
Editing WordArt Text
If you need to change the spelling or words of the WordArt you have created, just simply click inside the textbox and retype or correct the word you have typed.

Changing WordArt Font Face and Size
If the font or size of the WordArt letter does not suit your preference then feel free to use the WordArt toolbar to make changes.

Do these steps to change the WordArt font face and size to your liking.

1. Select the WordArt image by double clicking on it (in this case your name)
2. From the Font pull-down list, select a font, then from the font size pull-down list, select the size you wish for your text

Activity 2: This is a hands-on practical exercise. You must have a working computer that has PowerPoint application installed. In this practical exercise you will create a single slide PowerPoint presentation. Your goal is to create exactly the same presentation like the one shown below. Do not forget to save your file under the filename “PP Practical 6.”

1. Open PowerPoint and create a single slide presentation. Remove all text boxes from the presentation slide. Create a WordArt image like the one below. Follow the text formatting as indicated in the image on the next page.
2. Edit the WordArt image above to create a presentation like the one on the other page.

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Summary
You now have come to the end of Lesson 10. In this lesson we have learned the definition and importance of inserting WordArt to our presentation. We did hands on exercises to experience how to add WordArt. Lastly, we also did a quick editing of our WordArt.
Practice Exercise 10

A. Select your answer from the choices given. Encircle the letter of your answer.

1. Which of the following statement is true?
   A. You can insert WordArt from Insert Tab in PowerPoint
   B. You can insert WordArt from File Tab in PowerPoint
   C. You can insert WordArt from Edit Tab in PowerPoint
   D. None of the above

2. Which of the following should you use when you want to add a Word Art to an existing presentation.
   A. File, WordArt
   B. Insert, WordArt
   C. Insert, Picture, From file
   D. Insert, Picture, WordArt

3. Which of the following includes special effects that can be applied to WordArt?
   A. Colour Fill
   B. Line Colour
   C. Rotating
   D. All of the above

4. WordArt is a text-styling feature that is available in the _________ suite of products.
   A. Microsoft Office
   B. Microsoft XP
   C. Apple Office
   D. All of the above

5. Inserts a decorative text on your slide
   A. Textbox  B. Design
   C. WordArt  D. Shapes

6. Is a gallery of text styles that includes effects such as mirrored or shadowed text
   A. Textbox  B. Shapes
   C. Text Style D. WordArt
B. Write True if the statement is correct and False if the incorrect on the blank space after each statement.

1. WordArt are not able to be edited for colour preferences. __________
2. Whenever a WordArt is selected the drawing toolbar appears __________
3. Fill colour is the colour outlining the letters __________
4. Once you select a style and enter your text in the WordArt dialogue box, your text is added to your slide. __________

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 2.

Answers to Activity 1

1. Note: If the student has copied exactly the image provided, then the student is said to have succeeded in this activity.

Answers to Activity 2

1. Note: If the student has copied exactly the first and second image provided, then the student is said to have succeeded in this activity.
Lesson 11: Adding Graphics from the Internet

Welcome to Lesson 11 of Unit 3. In Lesson 10, we learnt the steps on how to insert a Word Art in a Presentation, identified the menu for Word Art, used Word Art in a Presentation and identified the importance of using Word Art in a Presentation.

In this lesson, we will about how to add graphics from the Internet to a presentation. We will also state the do's and don't in using graphics from the Internet and state the rules in acknowledging source., Finally we will state the importance of adding graphics from the Internet.

Your Aims:
- identify the process of adding graphics from the internet
- correctly and ethically use graphics from the internet

What is Internet?

Today we will learn about adding graphics from the Internet. You may find this topic as a review of Lesson 9 (Inserting Graphics, Clip Art, and/or Digital Pictures to a Presentation). Both Lesson 9 and 11 use the same method in adding graphics to a presentation. The only difference is where the images come from. Let us now start with our lesson. If you get lost on any part of the reading, do not hesitate to go through the topic again so that you get a hang of what this lesson is all about.

Now we will learn another way of searching for images to add into our presentation using the internet.

Internet is a way of connecting your computer to any other computer anywhere in the world via dedicated routers and servers. When two computers are connected over the Internet, they can send and receive all kinds of information such as text, graphics, voice, video, and computer programs.

Router is a device that connects two networks over large distance.

Server a part of a network. It is a machine with plenty of storage capability, so plenty of users can save and use resources.

Searching the Internet for images

There are many image store rooms out on the internet, but the quickest way to find images is through the search engine. Most major search engines allow image searching, but the widely used search engine is the Google, for its effectiveness and simplicity. When searching make sure you are searching for images only.

Search Engine are programs that search documents for specified keywords and return a list of the documents if the keywords were found.
In the next part of our lesson, it is important to have a working computer that has PowerPoint program and an internet connection. Follow the steps and do not skip anything.

1. Open your **web browser**. There are different types of web browsers. But your computer should have the Internet Explorer as a default. Look for this logo and click it.

   ![Web Browser logo]

   **Web Browser** is an application software or program designed to enable users to access, retrieve and view documents and other resources on the Internet.

2. After clicking the Internet Explorer logo, the web browser would open, in the address bar of the browser type the web address **www.google.com**, refer to the image below to identify where the address bar is located.

3. On the search box below the Google logo type the category of image you are looking for, example: image of flower (type flower if you are looking for images of flowers).

4. Click the **Google Search** button.

5. Google will display the images that you have searched. See the image on the next page.

6. Keep this search result open for the next part of this lesson.
Activity 1:  Write a brief explanation.

1. Give one advantage of searching images for PowerPoint using the Internet.

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________
___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answer. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Inserting Images to PowerPoint

In the earlier part of this lesson we discussed how to search or look for images on the internet. In this part, we are going to insert those images to our PowerPoint presentation. You can refer to Lesson 9 on how to search an image on the internet.

1. With the images that you have searched, select a picture that to use in your presentation.
2. Right click once your mouse pointer is over the picture you want. When the pop up menu appears click **Save Pictures As**

![Image of pop-up menu with 'Save pictures' highlighted]

Once you have decided on an image right click that image

3. When the Save Picture window opens, be sure that beside the **Save in:** it shows **My Pictures** folder.

![Image of Save Picture window with 'My Pictures' selected]

4. Replace the filename with "floewers"

5. Click the **Save** button. This will save the image to your computer.

6. Now, open the PowerPoint Window.

7. Click the Insert Menu Tab, go to Pictures.
8. When the Insert Picture Window appears, browse to the My Pictures folder and select the image that you have saved earlier. Then click Insert.
8. The image will now be inserted onto your PowerPoint Presentation.

| Yahoo | is an Internet doorway that includes a search engine and a directory of World Wide Web sites organized in a ladder of topic categories. |
| Copyright | is any material that is protected by law from someone else using. If something is protected under a copyright and you use their material exactly as it is written you can face legal action from the owner of the material. Always seek permission from the owners of the material if you want to use their work. |
| Be alert of the fact that pictures you find on the Internet may be copyrighted. Google and Yahoo clearly say that you must go to the original website where images are from and follow with that site's copyright policy. There are many Clip Art sites that clearly give permission for you to use their images as you see fit. The details differ, but in general, these sites allow you to use and even adjust the graphics for your own purposes. You are not allowed to rearrange the graphics. In some cases you are expected to indicate the website whenever you use the image. In other cases you are limited from using the graphics for any for profit purposes. |

Activity 2: Write a brief explanation.

1. Why is it that important to be alert of copyright issues when using images from the internet?

___________________________________________________________________
___________________________________________________________________
___________________________________________________________________

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Summary
You now have come to the end of Lesson 11. In this lesson we have learned how to search images from the internet, added our searched images to our PowerPoint presentation, and identified the importance of copyright.

NOW DO PRACTICE EXERCISE 11 ON THE NEXT PAGE.
Practice Exercise: 11

A. Write True if the statement is correct and False if it is incorrect on the blank space after each statement.

1. Internet can give very limited images that we can use for our presentation? __________
2. Google is the only search engine that we can use to search for images. __________
3. There is no other web browser except Internet Explorer. __________
4. Web address is normally typed in on the search bar. __________
5. The search bar of Google is located at the top of the web browser screen. __________
6. You need to save the images you searched from the internet before you can put it on your presentation. __________
7. Internet is connected only using a Router. __________
8. When saving images from the internet, you should put it in the My Pictures folder. __________
9. Internet Explorer is the default browser for the Windows Operating System. __________
10. To insert an image from the internet to your presentation you need to go to the File Menu. __________

Answers to Activity 1

1. Using the internet to search for images to use in a presentation can give you more choices for a presentation because we are not limited to what is given by the computer such as the clipart images.

Answers to Activity 2

1. We must be aware of copyright issues, because there are original owners of the images we are trying to use from the internet. If proper permission is not sought or instructions from the owner is not followed, we may face legal action.
Lesson 12: Adding Animation Schemes

Welcome to Lesson 12 of Unit 3. In Lesson 11, we identified the steps of how to add graphics from the Internet to a presentation. We also learnt about the do’s and don’ts in using graphics from the Internet and stated the rules in acknowledging sources and stated the importance of adding graphics from the Internet.

In this lesson, we will identify the steps required to add animation schemes, add animation schemes to a Presentation and state the importance of adding animation to a Presentation.

Your Aims:
• identify the different available animation schemes
• add appropriate animation schemes to a presentation

Applying Animation Schemes

Let us now begin this next lesson. Avoid skipping any part of the lesson. If you find it confusing do not hesitate to read the contents once again, then follow through with the steps provided.

Animation schemes in PowerPoint allow you to add fixed visual effects to paragraphs, bulleted items and titles. Using an animation scheme keeps your presentation consistent throughout. It is a quick way to emphasise sections of your presentation.

PowerPoint’s animation schemes is a quick way to add motion or movement to the contents of your slides. You must be infront of a computer with PowerPoint program installed to do this. Open PowerPoint and follow the instructions, do not skip any step. Here are the steps in adding animation to your presentation.

1. We will be creating a one slide presentation. On the first slide click the Add a title box to add a title, and type —Papua New Guinea”. Refer to the image below.
2. Select the text ―Papua New Guinea‖ then select Animations from the ribbon bar. On the Animation group, point your mouse over any animation. The preview of the animation will automatically show on your slide.

Select the Animations menu Tab from the Ribbon Bar.

Point your mouse over any of these animations, there is an automatic preview on the slide pane.

Click the arrow for more animation.

3. After selecting the appropriate animation settings, use the Preview button beside the Animation group to see the animation in action.

It is recommended that the number of animation be limited so that it does not distract the audience from the content on the slide.

To maximize audience interest while minimizing the potential distractions, the type of animation used should be relatively quick, simple, and consistent from slide to slide.

The Importance of Animation in PowerPoint
When animation is used properly, animations can, among other things:

1. help the audience remember a part of your presentation
2. represent a connection between ideas
3. highlight the movement of a topic
4. add visual representations to difficult ideas
Activity 1: In this activity you will be doing a practical exercise. You will be creating a two slide presentation. Remember that you must be infront of a working computer with PowerPoint application installed. Open a new presentation in PowerPoint program before you start with step 1.

1. Type the following text, follow the Slide number.

   Slide 1: TITLE: My Grandfather’s Bilum
   SUBTITLE: By: Jeffrey Febi

   Slide 2: How grandfather’s bilum, which
   Across my father’s bare chest,
   In a loving embrace slung.
   Like the Leleki baskets’ blest
   How while so pregnant swung.

2. Select the title. From the ribbon bar select Animation.
3. From the Animation group select Zoom.
4. Select slide number 2. From the animation group, select Fade.
5. Click preview to see the animation.
6. Save your work in your computer as My Poem.

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answer. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Summary
You now have come to the end of Lesson 12. In this lesson we have learned how to animate the text in our presentation using Animation Scheme. We have also learned the importance of using animation scheme in enhancing our presentation.
A. Select your answer from the choices given. Encircle the letter of the correct answer.

1. What PowerPoint feature can you use to apply motion effect to different objects of a slide?
   A. Slide Transition       C. Animation Object
   B. Slide Design         D. Animation Scheme

2. Which tab provides you options like Animation Scheme, Custom Animation, Slide Transition.
   A. Insert Tab        C. Tools Tab
   B. Format Tab       D. Animation Tab

3. To start a Slide Show for a presentation, click
   A. the File menu choose Slide Show button
   B. from Slide Show menu choose Rehearse Timing
   C. the Slide Show button at the bottom of the taskbar
   D. from Slide Show menu choose Set up Show option

4. What is the easiest way to apply various animations to test on slides?
   A. All of the above
   B. Apply an animation scheme
   C. Customise bullets with animated clipart
   D. Apply effects in the custom animation text pane

5. An Animation Scheme effect allows you to
   A. Add clipart images to your slides
   B. Show images as they are discussed
   C. Show bullet items as they are discussed
   D. Create a custom transition to the next slide

6. Animation Schemes can be applied to __________ in the presentation.
   A. all slides           C. current slide
   B. select slides       D. all of the above

7. An Ellipse motion is a built in
   A. Colour scheme
   B. Animation scheme
B. Write True if the statement is correct and False if the incorrect on the blank space after each statement.

1. Animation Scheme is a hard way of adding animation to your presentation.  
   _________

2. Animation should be limited so it does not distract the audience away from the content that the animation is being used on.  
   _________

3. There are only two groups of animation in the Animation Scheme, namely, Moderate and Exciting.  
   _________

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 2.

Answers to Activity 1

1. The animation of a presentation should play when the Slide Show command or the F5 key is pressed.
Answers to Practical Exercises

Practical Exercise 7

1. 4.

2. The Caves of the Kosua

By Stephen Reed & Stephen McCollin
(an article from the "Paradise Magazine")

The Location

* Our base camp was in the village of Empuraua. This is a small community located on the eastern slopes of the enigmatic Mount Bosavi. It is surrounded by the rainforest of the Upper Kikon int
ear Southern Highlands.

The Goal

* To be the first people to record, map, explore and discover the caves and underground rivers that riddle the landscape to the east of Mount Bosavi and into the basal plateau.

3. The Local People

* The region is the homeland of the Kosua people who have lived in complete isolation from the outside world until relatively recently. They retain a great deal of their traditional ways and the famous PNG hospitality is on full show.

Practical Exercise 8


B. 1. False 2. False 3. False

Practical Exercise 9


8. D

B. 1. False 2. True
Practical Exercise 10


Practical Exercise 11

1. False
2. False
3. False
4. False
5. False
6. True
7. False
8. True
9. True
10. False

Practical Exercise 12

B. 1. False  2. True  3. False

End of Topic 2.

Now Do Exercise 2 in Assignment Book 2 Then Go to Topic 3.
Lesson 13: Adding a Hyperlink to a Presentation
Lesson 14: Inserting a Chart to a Presentation
Lesson 15: Inserting Sound File to a Presentation
Lesson 16: Inserting Video File to a Presentation
Lesson 17: Adding Custom Animation to a Presentation
Lesson 18: Adding Slide Transition to a Presentation
TOPIC 3: ENHANCING PRESENTATION

In this topic you will learn the concepts of Enhancing your Presentation. The Topic is designed to familiarise you with the terminologies and icons used in enhancing a PowerPoint presentation.

In the previous topics you studied Introduction to PowerPoint and the basic of adding artistic designs to your presentation, in this topic you will learn how to enhance your presentation using different features of PowerPoint.

In this topic, you will study the following:

**Lesson 13** is about Adding a Hyperlink to a Presentation. You will learn to link your slide to a different slide or your presentation to another presentation.

**Lesson 14** is about Inserting a Chart to your presentation. You will learn how to enhance your data presentation using charts.

**Lesson 15** is about Inserting Sound File to your Presentation. You will learn how to add music to your presentation.

**Lesson 16** is about Inserting Video File to a Presentation. You will learn how to add video to a presentation.

**Lesson 17** is about Adding Custom Animation to a Presentation. You will learn about animating objects to your slide.

**Lesson 18** is about Adding Slide Transition to a Presentation. This is the lesson that will teach you how to animate your slide.
Lesson 13: Adding a Hyperlink to a Presentation

Welcome to Lesson 13 of Unit 3. In Lesson 12, we identified the menu for adding animation schemes and learned to add animation schemes to a Presentation. We also stated the importance of adding an animation scheme to a Presentation.

In this lesson, we will discuss the meaning and purpose of hyperlink and describe the steps of adding hyperlink. We will also add a hyperlink and state the importance of adding a hyperlink to a presentation.

**Your Aims:**
- define hyperlink
- identify the process of adding hyperlink in a presentation
- appropriately add a hyperlink to a presentation

PowerPoint allows you to add hyperlinks to your slides to make them more interactive. A hyperlink can link to a web site which provides more information for your presentation. Hyperlink can link contents to various sources. For this lesson, we will focus on hyperlinking to another slide in your presentation, to an external slide from another presentation saved in your computer or flashdrive, to an email address or to a web page.

**Interactive** relates to a human user. Often in a conversational way, to obtain data or commands. It gives immediate results or updated information.

**Hyperlink** or as it is more commonly called, a link, allows the viewer to quickly access another screen on the computer by simply clicking on a text entry or a graphic object.

In PowerPoint 2010, you can create internal hyperlinks that allow you to jump from one slide to another and external hyperlinks that jump to other presentations, documents, or a web site. You can even create a hyperlink that addresses an e-mail.

**Creating a Hyperlink to another Slide in your Presentation**

The next part of our lesson is a hands on activity. You will add a hyperlink to a slide. Follow each step in this part of the lesson. If you get confused, do not hesitate to repeat the steps until you understand how to do it correctly.

1. You will create a seven slide presentation. On the next page are images of the slides you must create. It already includes the text that you must input in each slide. Type the text and save your presentation with the filename “Regions of Papua New Guinea”.
The Regions of Papua New Guinea

Click to add subtitle

Regions of PNG

- The four regions of Papua New Guinea are its broadest scale administrative divisions. While the twenty-two province-level divisions are the primary administrative divisions of the country, the regions are quite significant in daily life, as they are often the basis for organisation of government services (such as police), corporate operations, sporting competitions, and even the machinations of politics.

Regions of PNG

People generally identify quite strongly with their region, and inter-region rivalries can be intense. The Four regions are:

- Highlands Region
- Islands Region
- Momase Region
- Papua Region

Click each region to see the provinces under it.

Highlands Region

- Simbu
- Eastern Highlands
- Enga
- Hela
- Jiwaka
- Southern Highlands
- Western Highlands
2. We are now going to add a hyperlink to Slide number 3. Select the word "Highlands Region".

3. Click the Insert Menu tab, then click the hyperlink command.
4. The Insert Hyperlink dialogue box will appear. Click "Place in this Document."

5. Choose a Slide under "Select a place in this document". For this exercise, Select slide 4 "Highlands Region", then click the OK button.

6. You will note that the word "Highlands Region" on slide 3 will change font colours and will appear underlined.

7. To test if the hyperlink you created works, click the Slide Show tab then click "View Show". Click your mouse until you reach slide number 3.

8. Put your mouse cursor on top of the phrase "Highlands Region". The arrow will change to a hand pointer. This shows that the text is hyperlinked.
Regions of PNG

People generally identify quite strongly with their region, and inter-region rivalries can be intense. The Four regions are:

- Highlands Region
- Islands Region
- Momase Region
- Papua Region

Click each region to see the provinces under it.

9. Click the phrase “Highlands Region”. This will cause the slide to jump to slide number 4 where the list of provinces of Highlands Region is listed.

10. Leave this work open for the next activity.

**Activity 1:** In this activity you will continue the exercise. You will add hyperlink for the Islands Region, Momase Region and Papua Region.

1. If you closed the file “Regions of Papua New Guinea” from the previous exercise, open it again. If you still have it open then proceed to step 2.

2. Go to Slide 3 of your presentation and select the phrase “Islands Region”.

3. Go to Insert Menu tab and click Hyperlink. On the Insert Hyperlink dialog box, select slide number 5 “Islands Region”

4. Complete the hyperlink for remainder of the regions on Slide 3 and linking them to the correct target slides.

5. Close and save your work.

Thank you for completing this activity. You may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.

**Creating a Hyperlink to an External Slide**

Earlier we learned how to create a hyperlink to other slides in the same presentation. In this part of the lesson, you will learn how to create a hyperlink to a Slide from another presentation, to an Email, and to a Web page.
An external slide, is a slide belonging to another Presentation. It also means that you are going to link one presentation to another. Here are the steps to create the hyperlink.

1. Open the file —“Regions of Papua New Guinea” for this activity.
2. Select the text that you want to use for the hyperlink.
3. Click the Insert Menu Tab from the Ribbon bar, and click Hyperlink.
4. From the Insert Hyperlink dialogue box, click Existing File or Web Page.

5. To test if the external hyperlink works. Click Slide Show on the menu bar, then click —ViewShow.” Put your mouse cursor on top of the hyperlinked text, the arrow will change to a hand pointer. Click the hyperlinked word which will direct you to the linked document.

6. Close and save your work.

**Creating a Hyperlink to an Email**

Adding this hyperlink can help the audience of your presentation to quickly access information. Follow the steps below to create a hyperlink to an email.

1. Open the file —“Regions of Papua New Guinea”
2. Select the text that you want to use for the hyperlink. In this case, it will be better if the text is an email address, for example: fode@educ.gov.pg
3. Click Insert Menu Tab from the Ribbon bar, and click Hyperlink.
4. From the Insert Hyperlink dialogue box, click E-mail Address. Fill up the E-mail address and Subject and click OK.

5. Close and save your work.

Creating a Hyperlink to a Web Page

Follow the steps below on how to create a hyperlink to a web page.

1. Open the file ―Regions of Papua New Guinea‖.
2. Highlight the text that you want to use for the hyperlink. In this case, it will be better if the text is a web page, for example: www.google.com
3. Click Insert Menu Tab from the Ribbon bar, and click Hyperlink.
4. From the Insert Hyperlink dialogue box, click Existing File or Web Page.

1. Click the Existing file or Web Page button.
2. Enter the Web Page Address then click OK.
The Importance of Hyperlink
A hyperlink within an article provides a source to other related articles. This is highly useful while working on research oriented works as it makes your research more unique and also makes the process very easy. A hyperlink creates a link to additional information that you cannot fit all in one slide. That way you can quickly switch to that information more easily then back to your presentation.

Activity 2: Write a brief explanation on the question given.

1. Explain the usefulness of hyperlinks in a presentation.

   ________________________________________________________________
   ________________________________________________________________
   ________________________________________________________________
   ________________________________________________________________
   ________________________________________________________________

Thank you for completing this activity. You may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Summary
You have now come to the end of Lesson 13. In this lesson, we have learned how to add hyperlink to our presentation. We practiced the steps on how to apply hyperlink to our presentation slide. We also learnt the importance of hyperlink to a presentation.

NOW DO PRACTICE EXERCISE 13 ON THE NEXT PAGE.
Practice Exercise:  13

A. Select your answer from the choices given. Encircle the letter of your answer.

1. To insert a hyperlink in a slide
   A. Choose Insert >> Hyperlink
   B. Press Ctrl + S
   C. Hyperlinks can not be inserted in slides
   D. Hyperlinks can open websites

2. The purpose of hyperlink is to _________
   A. link powerpoint slides
   B. link powerpoint presentations
   C. link all pictures
   D. link all files

3. To start creating a hyperlink, you ___________
   A. Go to Insert >> hyperlink
   B. Highlight the word you wish to use for hyperlink
   C. Select a slide or a presentation you wish to link
   D. Select all the files needed

4. Which of the following is an example of an email address in the correct format?
   A. www.google.com
   B. gov.pg
   C. John@fode.gov.pg
   D. altavista.com

5. There are four different types of hyperlink that you can insert in powerpoint, they are
   A. Existing File or Web Page, Place in this Document, Create New Document, E-mail Address
   B. Existing File or Web Page, Place outside Document, Create New Document, E-mail Address
   C. Existing File or Web Page, Place in this Document, Create New Presentation, E-mail Address
   D. Existing File or Web Page, Place in this Document, Create New Presentation, E-mail Address, Web Crawlers

6. Hyperlinks makes a presentation more _______________
   A. Active
   B. Interactive
   C. Interesting
   D. Colourful
B. Write True or False for each of the following on the space provided.

1. A hyperlinked word appears to have an underline. __________
2. You cannot link two different presentations. __________
3. Internal hyperlink can only link to the same slide. __________
4. You can send e-mail using the hyperlink. __________

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 3.

Answers to Activity 1

Slide number 3 should look like the image below. Click View Show from the Slideshow menu and click on the hyperlinks. Islands Region text should link to Islands Region slide (slide 5), Momase Region text should link to Momase Region slide (slide 6), Papua Region text should link to Papua Region slide (slide 7).

Regions of PNG

People generally identify quite strongly with their region, and inter-region rivalries can be intense. The Four regions are:

• Highlands Region
• Islands Region
• Momase Region
• Papua Region

Click each region to see the provinces under it.

Answers to Activity 2

A hyperlink within an article provides a source to other related articles. This is highly useful while working on research oriented works as it makes your research more unique and also makes the process very easy. A hyperlink creates a link to additional information that you cannot fit all in one slide. That way you can quickly switch to that information more easily then back to your presentation.
Lesson 14: Inserting a Chart to a Presentation

Welcome to Lesson 14 of Unit 3. In Lesson 13, we discussed the meaning and purpose of hyperlink, discussed the steps to add hyperlink, added hyperlink to a presentation, and stated the importance of adding a hyperlink to a presentation.

In this lesson, we will cover the different chart types. We will also identify the menu for inserting a chart and differentiate the purpose of each chart type. We will also describe the steps to insert a chart and finally state the importance of using different types of chart in a presentation.

Your Aims:
- identify the different chart types
- determine the process on how to insert a chart
- insert appropriate chart to a presentation

Charts are visual representations of data. Charts and graphs are an effective way of presenting information to your audience, more so than a simple list of numbers.

PowerPoint supports many kinds of charts to help you display data in ways that are meaningful to your audience. When you use the Chart Wizard to create a chart or when you use the Chart Type command to change an existing chart you can easily select the type of chart you want from a list of standard or custom types.

Different Types of Charts
There are 12 different types of charts in the Chart Wizard of Microsoft Powerpoint.

1. **Column Charts** show data changes over a period of time or illustrate comparisons among items. Column charts have the following sub-types:
   - Clustered Column This type of chart compares values across categories. It is also available with a 3-D visual effect. As shown in the following chart, categories are organised horizontally and values vertically. This emphasizes variation over time.

   ![Column Chart](image)

   **3-D stands for three dimensional. It enhances the illusion of depth. Essentially, it allows items that appeared flat to the human eye to be displayed in a form that allows for various dimensions to be represented. These dimensions include width, depth, and height.**
• Stacked Column – This type of chart shows the relationship of individual items to the whole. Compares the contribution of each value to a total across categories. It is also available with a 3-D visual effect.

• 100% Stacked Column – This type of chart compares the percentage each value contributes to a total across categories. It is also available with a 3-D visual effect.

• 3-D column – This type of chart compares data points along two axes. For example, in the following 3-D chart, you can compare four quarters of sales performance in Europe with the performance of two other divisions.

2. **Bar Charts** illustrate comparisons among individual items. Bar charts have the following sub types:

• Clustered Bar – This type of chart compares values across categories. It is also available with a 3-D visual effect. In the following chart, categories are organized vertically, and values horizontally, to place focus on comparing the values.

• Stacked Bar – This type of chart shows the relationship of individual items to the whole. It is also available with a 3-D visual effect.
3. **Line Charts** show trends in data at equal intervals. Line charts have the following sub-types:
   - Line – This type of chart display trends over time or categories. It is also available with markers displayed at each data value.
   - Stacked Line – This type of chart displays the trend of the contribution of each value over time or categories. It is also available with markers displayed at each data value.
   - 100% Stacked Line – This type of chart displays the trend of the percentage each value contributes over time or categories. It is also available with markers displayed at each data value.
   - 3-D Line – This is a line chart with a 3-D visual effect.

4. **Pie Charts** show the size of items that make up a data series, proportional to the sum of the items. It always shows only one data series and is useful when you want to highlight an important element in the data. Pie charts have the following sub-types:
   - Pie – This type of chart displays the contribution of each value to a total. It is also available with a 3-D visual effect, as shown in the following chart.
Exploded pie – This type of chart displays the contribution of each value to a total while emphasizing individual values. It is also available with a 3-D visual effect.

Pie of Pie – This is a pie chart with user-defined values extracted and combined into a second pie. For example, to make small slices easier to see, you can group them together as one item in a pie chart and then break down that item in a smaller pie or bar chart next to the main chart.

Bar of Pie – This is a pie chart with user-defined values extracted and combined into a stacked bar.

5. **XY (Scatter) Charts** show the relationship among the numeric values in several data series. They also plot two groups of numbers as one series of xy coordinates. Scatter charts are commonly used for scientific data and have the following sub-types.

- Scatter – This type of chart compares pairs of values. For example, the following scatter chart shows uneven intervals or clusters of two sets of data.
When you arrange your data for a scatter chart, place x values in one row or column. Then enter corresponding y values in the adjacent rows or columns.

### XY (Scatter) Chart

- Scatter with Data Points Connected by Lines – This type of chart can be displayed with or without straight or smoothed connecting lines between data points. These lines can be displayed with or without markers.

6. **Area Charts** emphasize the magnitude of change over time. Area charts have the following sub-types:

- **Area** – This type of chart displays the trend of values over time or categories. It is also available with a 3-D visual effect. An area chart also shows the relationship of parts to a whole by displaying the sum of the plotted values. For example, the following area chart emphasizes increased sales in Washington and illustrates the contribution of each state to total sales.
• Stacked Area – This type of chart displays the trend of the contribution of each value over time or categories. It is also available with a 3-D visual effect.

• 100% Stacked Area – This chart type displays the trends of the percentage each value contributes over time or categories. It is also available with a 3-D visual effect.

7. **Doughnut Chart** shows the relationship of parts to a whole. However, it can contain more than one data series. Doughnut charts have the following sub-types:

• Doughnut – this type of chart displays data in rings, where each ring represents a data series. For example, in the following chart, the inner ring represents gas tax revenues, and the outer ring represents property tax revenues.

![Doughnut Chart](image)

• Exploded Doughnut – This chart type is like an exploded pie chart, but it can contain more than one data series.

8. **Radar Charts** compare the aggregate values of a number of data series. Radar charts have the following sub-types:

• Radar – this type of chart displays changes in values relative to a center point. It can be displayed with markers for each data point. For example, in the following radar chart, the data series that covers the most area, Brand A, represents the brand with the highest vitamin content.

![Radar Chart](image)
• Filled Radar – In this type of chart, the area covered by a data series is filled with a colours.

9. **Surface Charts** are useful when you want to find optimum combinations between two sets of data. As in a topographic map, colours and patterns indicate areas that are in the same range of values. Surface chart have the following sub-types:

• 3-D surface – this type of chart shows trends in values across two dimensions in a continuous curve. For example, the following surface chart shows the various combinations of temperature and time that result in the same measure of tensile strength. The colours in this chart represent specific ranges of values.

![Surface Chart](image)

Displayed without colours, a 3-D surface chart is called a Wireframe 3-D surface chart.

• Contour – this is a surface chart viewed from above, where colours represent specific ranges of values. Displayed without colours, this chart type is called Wireframe Contour.

10. **Bubble Charts** is a type of XY or scatter chart. It compares sets of three values and can be displayed with a 3-D visual effect. The size of the bubble, or data marker, indicates the value of a third variable. To arrange your data for a bubble chart, place the x values in one row or column, and enter corresponding y values and bubble sizes in the adjacent rows or columns. For example, you would organize your data as shown in the following picture.

![Data for Bubble Chart](image)
The following bubble chart shows that Company A has the most products and the greatest market share, but not the highest sales.

Stock charts are most often used for stock price data, but can also be used for scientific data. For example, to indicate temperature changes. You must organize your data in the correct order to create stock charts. Stock charts have the following sub-types:

- **High-Low-Close** - This is often used to illustrate stock prices. It requires three series of values in the following order (high, low, and then close).

- **Open-High-Low-Close** - This type of chart requires four series of values in the correct order, that is open, high, low, and then close.

- **Volume-High-Low-Close** - This type of chart requires four series of values in the correct order, that is volume, high, low, and then close. The following stock chart measures volume using two value axes; one for the columns that measure volume and the other for the stock prices.
Volume-Open-High-Low-Close - This type of chart requires five series of values in the correct order of volume, open, high, low, and then close.

12. **Cylinder, Cone, or Pyramid Charts** These chart types use cylinder, cone, or pyramid data markers to lend a dramatic effect to column, bar, and 3-D column charts. Much like column and bar charts, cylinder, cone, and pyramid charts have the following sub-types:

- **Column, Stacked Column, or 100% Stacked Column** - The columns in these types of chart are represented by cylindrical, conical or pyramid shapes.

- **Bar, Stacked Bar, or 100% Stacked Bar** - The bars in these types of chart are represented by cylindrical, conical, or pyramid shapes.
• 3-D Column – These type of charts are represented by cylindrical, conical, or pyramid shapes.

Activity 1: Identify each illustrated chart below. Circle the letter of your answer.

1. [Illustration of a chart with bars and labels A. Bar Chart, B. Pie Chart, C. Column Chart]

2. [Illustration of a chart with a circular shape and labels A. Column Chart, B. Pyramid Chart, C. Doughnut Chart]

3. [Illustration of a chart with circular icons and labels A. Bar Chart, B. Surface Chart, C. Bubble Chart]

4. [Illustration of a chart with horizontal bars and labels A. Bar Chart, B. Bubble Chart, C. Column Chart]

5. [Illustration of a chart with scattered icons and labels A. Bubble Chart, B. XY (Scatter) Chart, C. Surface Chart]

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answer. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Inserting a Chart to a Presentation

In this part of the lesson, we will insert a chart to a presentation. Be sure that you have a working computer and a powerpoint presentation. If there is a part in this lesson that you do not understand, do not hesitate to repeat the reading and the exercise.
1. You can insert a graph by selecting the Insert Menu Tab > Chart. A new window opens showing a dummy spreadsheet. A graph based on that dummy data, and chart menu and toolbar options become activated.

2. Let us experiment with the dummy spreadsheet by clicking on a cell and typing our own data, to understand how the data affects the chart.

3. Look at the difference between the chart on your computer and the chart below. Type the data in the spreadsheet below to the one you have on your computer.

4. When you have finished entering the data, exit the work window by clicking anywhere outside the chart or the data sheet. The data sheet will disappear.

   If you need to make any changes to the chart, double-click the chart and the data sheet will appear again. Then make your changes and exit again.

   Your graph should be exactly like the one below using the data provided in step 3.

5. You can explore this feature by changing the data with your own values and see how it affects the final chart.
The Chart and Data menus are active only when the chart is selected and the data sheet window is open. Double-click on the chart to open the data sheet and activate the chart menu.

6. If you wish to use another chart, you can select another type of chart through the Chart menu then select the Chart Type.

**Importance of Using Different Types of Chart**

Here are some reasons to know why it is important to use different kinds of charts.

1. Charts help people understand data quickly.
2. Line Charts are most useful for showing trends over time, and for showing how two or more variables compare to one another.
3. Bar Charts represent the measured value or frequency. The higher the occurrence or longer the bar, the greater the value.
4. Pie Charts compare parts to a whole. As such it shows a percentage distribution of the parts of a whole.
Activity 2: This is a hands-on practical exercise. You must have a working computer that has PowerPoint application installed.

1. Create a 2 Slide Presentation and enter the following content on each slides. 
   Slide 1: Chart Exercise as title.
   Slide 2: Insert a Bar chart (Clustered Bar in 3D).

2. Save your file under the filename —Chart Activity.”

   Use the default data for this practical exercise, your goal is to only change the bar chart into a pie chart.

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answer. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Summary
You have now come to the end of Lesson 14. In this lesson you have learned about the different types of charts. You have also learned how to insert charts and enumerated the importance of charts on a presentation.

NOW DO PRACTICE EXERCISE 14 ON THE NEXT PAGE.
Practice Exercise 14

A. Select your answer from the choices given by placing a circle around the letter of your choice.

1. This type of chart is useful when you want to highlight an important element in the data.
   A. Bar Chart
   B. Surface Chart
   C. Pie Chart
   D. None of the above

2. Which of the two charts shows in 3-D visual effect.
   A. 
   ![Chart Image]
   B. 
   ![Chart Image]

3. In order to edit (change) a chart, you can__________
   A. Click the chart object.
   B. Triple click the chart object.
   C. Double click the chart object.
   D. Click and drag the chart object.

4. What is the name of the form used to input chart values?
   A. Autoform
B. Datasheet  
C. Microsoft Excel  
D. Microsoft Graph

5. Which of the following options correctly shows the steps of inserting a chart into a presentation.  
A. Click Insert Menu → Chart  
B. Click Chart Menu → Chart  
C. Click Table Menu → Chart  
D. Click Review → Chart

6. This type of chart shows the relationship of parts of a whole.  
A. Bar Chart  
B. Pie Chart  
C. Surface Chart  
D. Doughnut Chart

7. This type of chart displays changes in values relative to a center point.  
A. XY  
B. Radar Chart  
C. Bubble Chart  
D. Surface Chart

8. This type of chart is most often used for stock price data.  
A. XY  
B. Bar Chart  
C. Radar Chart  
D. Stock Chart

9. This type of chart compares three values  
A. Bar chart  
B. Pie chart  
C. Bubble Chart  
D. Line Chart

10. Answer this question as either True of False. Once you have inserted a chart, you can never change to a different chart type.  
A. True  
B. False
Answers to Activity 1

1. B
2. C
3. C
4. A
5. B

Answers to Activity 2

Your work should look exactly like the slides below.

![Chart Exercise](slide1)

![Chart](slide2)
Lesson 15: Inserting Sound File to a Presentation

Welcome to Lesson 15 of Unit 3. In Lesson 14, we have learned about the different chart types and identified the menu for inserting a chart. We also differentiated the purposes of each chart type, learned the steps to insert a chart and stated the importance of using different types of chart in a presentation.

In this lesson, we will learn the steps of inserting a sound file and state its importance.

Your Aim:
- identify the sound file locations.
- determine the process to insert a sound file
- insert appropriate sound to a presentation

Sound effects

Sound or audio effects, such as music and voice recordings, can add another level of professionalism to your slide presentations. Music is an effective way to introduce or end a presentation and it gives your audience something to listen to as they enter and leave the presentation room.

You can find sound files in several places like in the Clip Organizer, in the folder where you have chosen to store your audio files, on the Internet or from a network folder. There are many sound file formats. Two common ones are wave files with the .wav filename extension and MIDI files with the .mid, .midi, or .rmi filename extension. After you add a sound to a slide, you will see a Sound icon.

In this part of the lesson you will learn how to insert a sound file to your presentation. We will do a two slide presentation for this exercise. Remember that you should have a working computer. On the first slide, type ―Sound Exercise‖ as the title of the slide.

1. Open PowerPoint for this exercise.

2. On the second slide, type the text you see on the image below.

3. There are three methods of adding a sound clip to your presentation, but we will be using the Clip Organizer for this lesson. The Clip Organizer already contains sounds that can be used for your presentation.

4. To add a sound clip using the Clip Organizer, do the following steps:
   4.a. On the ribbon bar, click Insert Menu Tab, choose Audio under the Media group.
4.b. Then click Clip Art Audio. Refer to the image below.

5. The taskpane will open and the available files stored on your computer will be displayed.

6. Look for the “Clap Cheers” sound file and click to select it.

7. The sound icon will now appear on your slide. It will look like the image below.

8. Click and drag the sound icon next to the “Clap Sound” text. Your slide should now look like the one below.
9. On the task Pane, look for the sound file "Telephone" and add it as you have done with the clap sound.

10. Your second slide should now look like the image below.

![Sound icons on a slide]

11. To test if the sound file works, do the following steps:
   11.a. On the Ribbon Bar, click Slide Show Tab and select From Beginning.
   11.b. On the second slide, click the sound icon one by one. You should be hearing the sound right after you click the sound icon.

**Importance of Inserting a Sound File**
Inserting a sound file to your presentation is important because it adds more interest to your presentation. It also attracts more attention from your audience and people tend to remember your topic more if it has music in the background.

---

Activity 1: State the advantages of adding a sound file to your presentation.

---

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answer. Make sure you do the necessary corrections before moving on to the next part of this lesson.

**Summary**
You have now come to the end of Lesson 15. In this lesson you have learned about sound file and the steps used to insert sound to your presentation and sound file to your presentation.

NOW DO PRACTICE EXERCISE 15 ON THE NEXT PAGE.
Practice Exercise: 15

A. Select your answer from the choices given by circling the letter of your choice.

1. Audio is found in what group of the Insert Menu Tab?
   A. Tables  B. Media  C. Illustrations
2. The music that is pre-loaded with PowerPoint can be found in the
   A. Clip Organizer. B. Internet. C. File Folder.
3. There are two types of sound files that can be inserted to a presentation. These are
   A. WAV and MIDI. B. Jpeg. and .Png. C. Html ang Htm
4. What are the proper steps to follow in adding a sound to your presentation?
   A. Insert → Audio → Clip Art Audio
   B. Menu → Audio → Clip Art Audio
   C. Tools → Audio → Clip Art Audio
5. What is the name of this icon? 
   A. Speaker  B. Icon  C. Sound Icon
6. How can you test the sound file to see if it would play in your presentation?
   A. Play the presentation and then click the sound icon.
   B. Click the sound icon.
   C. Do nothing, it will automatically play.

B. Write True if the statement is correct and False if it is incorrect on the space provided.

1. You are not allowed to add more than one sound file into your presentation. 
   _________
2. Music can add excitement to your presentation. 
   _________
3. Music distracts the attention of the audience from your presentation. 
   _________
4. Music is an effective way to start a presentation but not to end it. 
   _________

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 3.

Answers to Activity 1
The advantage of adding a sound file to a presentation is that your presentation will look more professional and catch the interest of your audience.
Lesson 16: Inserting a Video File to a Presentation

Welcome to Lesson 16 of Unit 3. In Lesson 15, we identified the steps on how to insert a sound file, outlined the steps to insert a sound file and inserted a sound file into a presentation. We also discussed the importance of inserting a sound file to a presentation.

In this lesson, we will identify the steps of how to insert a video file into a Presentation. We will also learn about the importance of inserting a video file to a Presentation.

**Your Aims:**
- identify the video file locations
- determine the process on how to insert a video file
- insert appropriate video to a presentation

**What is a Video?**

A **video** is a digital way of recording, copying and broadcasting of moving visual images.

You can insert one or more video clips, that is, movies into any slide. You might want to play a video quote from your product manager, for example, or run a short documentary movie for a fund-raising event.

Most of the movie clips stored in the Clip Organizer are simply animated .gif files. They are small files that contain an animated sequence of images. If you imported your own movie files into the Clip Organizer, you will find them generally stored in .avi format. You might be able to find additional movie clips on your network, intranet, or the Internet.

**Tip:** Before you insert video clips, think about the environment you will be presenting in. Does the computer you use have the necessary **hardware** such as a sound card, speakers, and an enhanced video card for playing the **multimedia** items during your presentation? You might consider adding only a few multimedia elements in case. If the computer you give your presentation on does not support them, plan an alternate way to make your presentation convincing. You will find that adding video and sound is the same as adding any other item to your slides and the special effects are truly exciting.

**Hardware** is the mechanical, magnetic, electronic, and electrical components making up a computer system.

**Multimedia** is the combination of multiple forms of media. This includes text, graphics, audio, video and so on. For example, a presentation involving audio and video clips would be considered a "multimedia presentation."

In this part of the lesson we will learn how to insert a video file to our presentation. We will be doing a two slide presentation for this exercise. Save the presentation with
the filename —Video Exercise”. Remember that you should have a working computer.

Insert a Movie using Clip Organizer
1. Open PowerPoint for this exercise.
2. On the first slide, type —Sound Exercise" as the title of the slide.
3. On the second slide, copy the text on the image below.

![Click to add title](image)

There are three methods in adding a video clip to your presentation, but we will use the Clip Organizer for this lesson. The Clip Organizer already contains videos that can be used for your presentation.

4. To add a video clip using the Clip Organizer, do the following steps:
   4.a. On the menu bar, click Insert MenuTab.
   4.b. Under the Media Group, click Video and select the Clip Art Video. Refer to the image below.

![This is the Clip Art Video.](image)

5. Taskpane will show all the available movie clip saved in your computer.

The other two methods of adding a video to a presentation are Video from File and Video from Web Site. Video from File is adding a video from a separate folder or from a camera or a video recorder. While, Video from Web Site is to add a video that you have searched from the internet.

Take note if you are adding a video that you have searched from the internet to your presentation, be aware of the copyright laws. Always acknowledge the source of your video.
6. Look for the “Fire” video clip, the video clip will have the icon like the one below:

These are the available movie clips, scroll the scroll bar down to view more options.

Note: In case the “Fire Video Clip” is not available in your computer, you may use other available video clips in the list.

7. Select the “Fire Video Clip” and click OK.

8. Click and drag the movie icon beside the “Fire” text. Your slide should look like the one on the next page.
9. On the task bar, look for the movie clip — Animated Image of two hands clapping”. Click and drag the movie icon beside the — Clap” text.

10. On the task bar, look for the movie clip — Communications, Computer”. Click and drag the movie icon beside the Communication text. After the last movie clip, your second slide should look like the image below.

11. To test if the video file works: on the ribbon bar, do the following steps:

11.a. Click Slide Show Tab and select From Beginning.

11.b. On the second slide all of your movie clips should start playing.
Insert a Movie from a File

Another option for inserting a video is from a file or a video clip from your camera, your local disk or from the internet.

The following are the steps in inserting a movie clip from a camera, local disk, or internet. Make sure that you have an Internet connection to do the steps below.

1. On the **Insert** Menu tab, click **Video** under the **Media** group. Then click **Video from File** or **Video from Website**.

If the video is from file, choose the location of the video file and click Insert.

If the video is from website, type the website address in the box as shown below then click Insert.

- To have the movie play automatically when the slide is displayed in a slide show, click the **Automatically** button.
To have the movie play only after you click the movie image, click the **When Clicked** button. PowerPoint will then add the clip to your slide.

**Importance of Inserting a Movie clip**
Including a video clip within a presentation can be powerful. If a picture can be worth a thousand words, a well-selected video clip can be worth a small book. If used properly, digital video can raise our dialogue and improve your awareness in ways impossible with the printed word or an oral presentation.

---

**Activity 1:** This is a hands-on practical exercise. You must have a working computer that has PowerPoint application installed. In this practical exercise you will. The subject of the Presentation will be given to you, including all the text and the corresponding slide numbers they should be located in. Do not forget to

1. Open a PowerPoint and create a two slide presentation. Enter the following content on each slide.
   
   **Slide 1:** —**Movie Activity**” as the title of the presentation.
   
   **Slide 2:**
   - School Bus
   - Santa Claus Flying
   - Dog Barking

   Note: If the movie clips are not available you can use any available movie clips.

2. Insert the movie clip that corresponds to each text following the steps you have learned.

3. Test if the movie clip is working by playing the slideshow and clicking on the icon.

4. Save your file under the filename —**Movie Activity”**.

---

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answer. Make sure you do the necessary corrections before moving on to the next part of this lesson.

**Summary**

You have now come to the end of Lesson 16. In this lesson, we have learned about movie clips and the steps in inserting it to a presentation. You also learned the importance of using it.
**Practice Exercise: 16**

**A. Select your answer from the choices given and circle the letter of your choice.**

1. Most of the video clips stored in the Clip Organizer are simply animated ______________ files.
   - A. .jpeg  
   - B. .png  
   - C. .gif

2. There are many areas where you can find video clip for your presentation, but the movie that is pre-loaded with PowerPoint is in the ____________
   - A. Clip Organizer  
   - B. Internet  
   - C. File Folder

3. What's the best place to find animated images for your PowerPoint presentation?
   - A. Microsoft Online  
   - B. Clipart  
   - C. Clip Organizer

4. What are the proper steps to follow in adding video clip to your presentation?
   - A. Insert → Video → Clip Art Video
   - B. Menu → Video → Clip Art Video
   - C. Tools → Video → Clip Art Video

5. How can you test if the video clip will correctly play in the presentation?
   - A. Play the presentation.
   - B. Click the video clip.
   - C. Do nothing, it will automatically play.

**B. Write True if the statement is correct and False if it is incorrect on the space provided.**

1. You are not allowed to add more than one movie clip into you presentation.
   ________

2. A video clip in a presentation can be worth a small book. ________

3. Movie clip can only be inserted from the clip organizer and not from other location. ________

4. When inserting video clip to a presentation you must consider the hardware components of your computer. ________
5. Multimedia means video presentation only. __________

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 3.

Answers to Activity 1

Slide 1

Movie Activity

Slide 2

Look at the Moving Images

- School Bus
- Santa Claus Flying
- Dog Barking

Note: Images on Activity 1 may vary depending on the availability of the images on your computer.
Lesson 17: Adding Custom Animation to a Presentation

Welcome to Lesson 17 of Unit 3. In Lesson 16, we identified the steps on how to insert video file. We enumerated the steps on how to insert a video file, inserted a video file using identified procedure, and stated the importance of inserting a video file to a Presentation.

In this lesson, we will identify the menu for adding custom animation. We will identify the steps to add custom animation and add a custom animation and effects in a presentation. We will also learn the importance of adding custom animation to a Presentation.

Your Aims:
- identify the different custom animations and effect options available
- determine the process on how to add custom animation
- add appropriate animations and effect options to a presentation

Custom Animation

Read the following explanations of Custom Animation and follow the steps in the hands on activity to learn how to Add Custom Animation to a Presentation. Then be prepared to answer the questions that follow.

Custom Animation and animation effects are terms used to describe motions and effects applied to objects on your slide, such as pictures, text and other graphics.

Adding Custom Animation
In this part of the lesson we will be adding Custom Animation to an object in a slide. This is a hands on practical exercise. Be sure you have a working computer with PowerPoint 2010 installed. If you do not understand some areas of this lesson, do not hesitate to start all over again. Let us start the practical exercise now.

1. Open a new PowerPoint presentation.
2. We will create a two slide presentation. On the first slide type —Custom Animation— as the title of the presentation. Save the file with the filename Custom Animation Exercise.
3. Add a second slide for this presentation. Click the Insert Menu Tab on the Ribbon Bar, and click Clip Art.
4. The task pane will open. Under the Search for: type —Flower—, different images of flowers will appear on the task pane.

Note: If the images in this exercise are not available on your computer, you can always select any image that is available.
5. Choose three flower images and arrange them on the second slide. Your second slide might look like the image on the next page. Images might differ, depending on your choice of images.

6. Click on the first image of the flower, preferably the one on the left.

7. Click the **Animations Menu** tab on the **Ribbon Bar**.

   Click on the **Animations Tab**.
8. When you are working with a lot of animation on a slide, it can be easy to lose track of what is moving and when. The **Animation Pane** can help you organize your animations and their timing.

   Click to display the **Animation Pane** on the right side of your window.

   Currently it will be empty but when we add some animations they will be listed in the order that they will occur in the Animation Pane.

9. Click **Add Animation**.

10. Scroll down the list of animations on the **Entrance** category. Choose **Zoom**.

11. Click the second image on the right and click **Add Animation**.

12. Scroll down the list of animations on the **Emphasis** category. Choose **Grow/Shrink**.

13. Now, click the third image and click **Add Animation**.

14. Scroll down the list of animations, on the **Exit** category, choose **Float Out**.

15. Compare your Animation Pane to the image of the Animation Pane as shown below. It should look exactly the same.

16. Click the **Play** button at the top of the animation pane to see your animation again.
17. Press [F5] or Slide Show MenuTab on the Ribbon bar and click From Beginning. The images will begin moving according to the animation options you chose.

18. Press [ESC] to exit the slideshow.

**Importance of Custom Animation**

Custom Animation can help focus the attention of the audience on an important point. Many presenters like to add animation to make their presentations hold the interest of the audience while discussing on important points.

---

**Activity 1:** This is a hands-on practical exercise. You must have a working computer that has PowerPoint application installed.

1. Open a PowerPoint presentation and create a 2 Slide presentation. Type the following content on its corresponding slide.

   Slide 1: “Custom Animation Activity” as the title of the presentation.

   Slide 2: insert four images of the “Plant” category from the Clip Art images.

2. Add different animation to each image.

3. Play your slideshow to see if the custom animation works.

4. Save your file under the filename “Custom Animation Activity.”

---

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answer. Make sure you do the necessary corrections before moving on to the next part of this lesson.

---

**Summary**

You have now come to the end of Lesson 17. In this lesson you have learned the definition of Custom Animation and its importance. You also applied it to your presentation.

---

NOW DO PRACTICE EXERCISE 17 ON THE NEXT PAGE.
Practice Exercise: 17

A. Select your answer from the choices given and circle the letter of your choice.

1. To preview an animation effect using the custom animation task pane, you should
   A. click the play button
   B. click the show effect button
   C. double click the animation
   D. all of the above

2. What PowerPoint feature will you use to apply motion effects to different objects of a slide?
   A. Slide Transition
   B. Slide Design
   C. Custom Animation
   D. None of the above

3. Which Tab on the Ribbon Bar provides you options like Add Animation and Animation Pane?
   A. Insert   B. Home   C. Animations   D. Slide Show

4. When using PowerPoint, to play a PowerPoint show for previewing the show, select
   A. Slide Show >> Hide Slide
   B. Review Tab >> Play Show
   C. Slide Show >> From Beginning
   D. Animations Tab >> Add Animations

5. When an image is selected, it displays which of the following?
   A. Six boxes
   B. Six middle handles
   C. Two corner handles
   D. Eight sizing handles

6. The ___________ Pane can help organize your animations and their timing.
   A. Tab
   B. Ribbon
   C. Animation
   D. Custom animation
7. How many categories of animations effects are there in the add animation options
   A. 1  B. 2  C. 3  D. 4

8. What keyboard key is the shortcut for Slideshow Presentation
   A. F2  B. F3  C. F5  D. F1

9. To preview the animation
   A. Click Play from the Animation Pane.
   B. Click Slideshow from the Slideshow Tab.
   C. Wait.
   D. Both A and B.

10. Choose either True or False. Custom animation distracts the audience of the presentation
    A. True  B. False

---

**CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 3.**

**Answers to Activity 1**

1. The students work might look a little different from the answers below, depending on the images used and the animation applied. However it is a must that the animation pane contains four animations.
Lesson 18: Adding Slide Transition to a Presentation

Welcome to Lesson 18 of Unit 3. In Lesson 17, we identified the menu for adding custom animation. We learned the steps to add custom animation and added a custom animation and effects in a presentation. We also learned about the importance of adding custom animation to a Presentation.

In this lesson, we will identify the menu for adding slide transition, the steps on how to add a slide transition to a Presentation and also learn the importance of adding a slide transition to a Presentation.

Your Aims:
- identify the different available slide transitions
- determine how to add slide transition
- add appropriate slide transitions to a presentation

Slide Transition

Read the following explanations on Slide Transition and follow the steps in the hands on activity to learn how to Add a Slide Transition to a Presentation. Then be prepared to answer the questions that follow.

Slide transitions are the animation-like effects that occur in Slide Show view when you move from one slide to the next during an on-screen presentation. You can control the speed of each slide transition effect and you can also add sound together with the transition.

Microsoft Office PowerPoint 2010 includes many different types of slide transitions, including (but not limited to) the following:

1. No transition
2. Blinds Horizontal
3. Blinds Vertical
4. Box In
5. Box Out
6. Checkerboard Across
7. Checkerboard Down
8. Comb Horizontal
9. Comb Vertical

To see more transition effects in the Quick Styles list, click the More button.

**Adding Slide Transition**

In this part of the lesson we will be adding Slide Transition to our presentation. This is a hands on practical exercise. Be sure you have a working computer with PowerPoint installed. If you did not understand any part of this lesson, do not hesitate to start all over. We will now start the practical exercise.

1. Open a PowerPoint and create a five slide presentation. On the first slide type ―Slide Transition‖ as the title of the presentation. Save the file with the filename Slide Transition Exercise. On the Subtitle type ―PNG National Pledge‖

2. Slide 2:

   **Click to add title**
   
   We, the people of Papua New Guinea pledge ourselves united in one Nation. We pay homage to our cultural heritage, the source of our strength.

3. Slide 3:

   **Click to add title**
   
   We pledge to build a democratic society based on justice, equality respect and prosperity for our people.

4. Slide 4:

   **Click to add title**
   
   We pledge to stand together as One People, One Nation, One Country God Bless Papua New Guinea

5. Select the first slide. Click the Transitions Menu Tab from the Ribbon Bar.

6. From the Transitions to This Slide group, click the Reveal transition. You will see a preview of the Reveal transition the moment you click it.
7. Select the second slide. From the Transitions to This Slide group, click the more button on the side. This will reveal more options for Transition animation.
8. Click the Glitter transition. You will see a preview of the Glitter transition the moment you click it.

9. Select the third slide. From the Transitions to This Slide group, click the more button seen on the side. It will reveal more options for Transition animation. Click the Vortex transition. You will see a preview of the Vortex transition the moment you click it.

10. Select the fourth slide. From the Transitions to This Slide menu group, click the more button seen on the side. It will reveal more options for Transition animation. Click the Blinds transition. You will see a preview of the Blinds transition the moment you have clicked it.
11. Press [F5] or Slide Show Tab on the Ribbon bar and click From Beginning. The slide will do the transition the moment you click the mouse or press the keyboard keys.

12. Press [ESC] to exit the slideshow.

Use of Timing Group
You as the presenter can choose if you want to play your slide transition manually (on mouse click) or automatically (timing). The process is:

To use timing in the Transitions Ribbon → Timing Group, click in the check box next to After: and increase the Advance Slide time to 10 (ten) seconds, but leave the check mark in the box next to On Mouse Click.

Importance of Slide Transition
A slide transition helps make a PowerPoint presentation seem flawless. It is a subtle bit of animation that moves from slide to slide through the show.

Transitions is a way of providing cues to the audience that new information is being presented. If your slides have a uniform look or with the same backgrounds and colours then the transitions will be very effective.

If your slides just appear one after another like the PowerPoint's default setting where there is no transition then your audience could easily lose you on the way.

Activity 1: This is a hands-on practical exercise. You must have a working computer that has PowerPoint application installed.

1. Create a two slide presentation and enter the following content on slide.

   Slide 1: type “Papua New Guinea” as the title of the presentation. On the subtitle type “Slide Transition Activity.”
2. Slide 2:

Papua New Guinea, officially named the Independent State of Papua New Guinea, is a country in Oceania that occupies the eastern half of the island of New Guinea and numerous offshore islands.

3. Slide 3:

Papua New Guinea is one of the most culturally diverse countries in the world. According to recent data, 841 different languages are listed for the country, although 11 of these have no known living speakers.

4. Slide 4:

The majority of the population still live in traditional societies and practice subsistence based agriculture. These societies and clans have some explicit acknowledgement within the nation's constitutional framework.

5. Apply the following transitions on each slide:

   Slide 1 – Wipe
   Slide 2 – Checkboard
   Slide 3 – Ripple
   Slide 4 – Shred

6. View the slideshow to see how your transitions work out.

7. Save your file under the filename ―Slide Transition Activity.‖
Thank you for completing this activity. Now, you may go to the end of this lesson to check your answer. Make sure you do the necessary corrections before moving on to the next part of this lesson.

---

**Summary**

You have now come to the end of Lesson 18. In this lesson you have learned the definition of slide transition, identified the menus used to apply slide transition and learned the importance of slide transition.

---

NOW DO PRACTICE EXERCISE 18 ON THE NEXT PAGE.
Practice Exercise: 18

A. Select your answer from the choices given. Encircle the letter of your answer.

1. Special effects used to introduce slides in a presentation are called
   A. Effects
   B. Custom Animations
   C. Transitions
   D. Present Animations

2. Which of the following group can you use to add times to the slides in a presentation
   A. Animation Group
   B. Preview Group
   C. Timing Group
   D. None of the above

3. Which Menu Tab provides options like Slide Transition?
   A. Insert Tab
   B. Home Tab
   C. Transitions Tab
   D. Slide Show Tab

4. The effect applied to display when slides changes in slide show is
   A. Slide Animation
   B. Custom Animation
   C. Custom Transition
   D. Slide Transition

5. In Microsoft PowerPoint the entry effect as one slide replaces another in a show is called a (an)
   A. Animation
   B. Slide Transition
   C. Custom Animation
   D. Preset Animation

6. Which of the following is not a transition effect?
   A. Wipe
   B. Honeycomb
   C. Ribbon
   D. Random Bars
7. There are two options in playing a presentation with transition, these are
   A. Manually and Automatically
   B. Manually and Timed
   C. Manually and Clocked
   D. None of the Above

8. You as a presenter are limited to a few slide transition only.
   A. True   B. False

9. What is the name of this button?
   A. Move Button
   B. More Button
   C. Mode Button
   D. Model Button

10. Slide transition helps make a PowerPoint presentation seem __________
    A. Endless
    B. Breathless
    C. Seamless
    D. Clueless

Answers to Activity 1

The students will be asked to play the presentation that they have done, once the presentation advances to the next slide there should be a slide transition witnessed by the instructor.
## Answers to Practice Exercises 13-18

### Practice Exercise 13

1. A  
2. B  
3. B  
4. A  
5. A  
6. C  
7. B  
8. C  
9. A  
10. B

### Practical Exercise 14

1. C  
2. B  
3. C  
4. B  
5. A  
6. D  
7. B  
8. D  
9. C  
10. B

### Practical Exercise 15

1. B  
2. A  
3. A  
4. A  
5. C  
6. B  
7. A  
8. A  
9. B  
10. B

### Practical Exercise 16

1. C  
2. A  
3. C  
4. A  
5. B  
6. A  
7. A  
8. B  
9. A  
10. B

### Practical Exercise 17

1. A  
2. C  
3. C  
4. C  
5. D  
6. B  
7. C  
8. D
9.  B 

10.  A 

---

**Practical Exercise 18**

1.  C 
2.  C 
3.  C 
4.  D 
5.  B 
6.  C 
7.  A 
8.  B 
9.  A 
10.  C 

---

**End of Topic 3**

---

**Now Do Exercise 3 in Assignment Book 3 Then Go to Topic 4.**
TOPIC 4

PRINTING AND SAVING

Lesson 19: Printing Slides
Lesson 20: Printing Handouts
Lesson 21: Saving a PowerPoint Show
Lesson 22: Saving Presentation as a Web Page
Lesson 23: Saving with Pack and Go
Lesson 24: Evaluating the Presentation
TOPIC 4: PRINTING AND SAVING

In this topic you will learn the concepts of viewing your presentation in different ways. The Topic is designed to familiarise you with the terminologies and icons used in saving and printing a presentation.

In the previous topic you were introduced to enhancing your presentation using different features of PowerPoint.

In this topic, you will study about the following:

Lesson 19 is about Printing Slides. You will learn how to print some slides or all the slides in your presentation or all the slides.

Lesson 20 is about Printing Handouts. You will learn another way of printing a presentation by the option of printing handouts.

Lesson 21 is about Saving a PowerPoint Show. You will learn another way of saving and transporting a presentation by saving your work as a PowerPoint show.

Lesson 22 is about Saving Presentation as a Web Page. You will learn a more technical way of saving and sharing a presentation.

Lesson 23 is about Saving with Pack and Go. You will be introduced to saving a presentation to a Compact Disc.

Lesson 24 is about Evaluating the Presentation. This is the lesson where you will be taught how to properly evaluate a presentation.
Lesson 19: Printing Slides

Welcome to Lesson 19 of Unit 3. In Lesson 18, we identified the menu for adding slide transition, described the steps on how to add slide transition, added a slide transition in a presentation, and listed the importance of adding slide transition to a Presentation.

In this lesson, we will print slides and stated the importance of printing slides following the correct procedure.

Your Aims:
- Discuss the correct process on how to print slides of a Presentation
- Print all slides or selected slides of a Presentation

Printing Presentation

Read the following explanations on printing Presentations and follow the steps in the hands on activities to learn how to print a Presentation. Be prepared to answer the questions that follow.

Although the primary way of viewing a presentation is usually as a slide show, you can also print PowerPoint slides, in the same way as you print Word documents or Excel worksheets. PowerPoint provides a variety of print options, including printing each slide on a separate page or printing several slides on the same page. Let us explore some of these options now.

Printing Slides

In this part of the lesson we will create a Presentation and print the slides. This is a hands-on practical exercise. Be sure you have a working computer with PowerPoint installed. If you did not understand some areas of this lesson, do not hesitate to start all over. We will now start the practical exercise.

1. Create a new Presentation and type the following in its equivalent slide, save your file with the filename — "Printing Slides Exercise."

Slide 1:
Slide 2:

Click to add title

O arise all you sons of this land,
Let us sing of our joy to be free,
Praising God and Rejoicing to be
Papua New Guinea.

Slide 3:

Click to add title

Shout our name from the mountains to seas
Papua New Guinea
Let us raise our voices and proclaim
Papua New Guinea.

Slide 4:

Click to add title

Now give thanks to the good Lord above
For His kindness, His wisdom and love
For this land of our fathers so free,
Papua New Guinea.

Slide 5:

Click to add title

Shout again for the whole world to hear
Papua New Guinea;
We’re independent and we’re free
Papua New Guinea.
2. From the **File Menu** Tab of the Ribbon bar choose **Print**.

3. Now click on the **Print All Slides** to bring up the drop down menu of print layout options. Refer to the image below.

![Print Menu](image)

4. In the drop down menu, click **Print Current Slide**. This option will only print the active slide from your presentation.

5. Also, click in the **Colour** box towards the bottom of the Print dialog box.

6. In the Colour options for the slides, select **Grayscale** (to print a black and white copy of your presentation), then click on **OK** to print a copy of the presentation.
There are other options in printing the slides apart from Print Current Slide. Print all Slides option gives you a choice to print all the slides in your presentation all at once. The other option is Print Selection, this gives you a choice to print only a slide that you want and not the entire presentation. And last is the Custom Range option, this gives you a choice to print the different slides in your presentation.

Activity 1: What is the purpose of printing a presentation?

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.
Summary
You now have come to the end of Lesson 19. In this lesson you have learned another way of viewing your slide and that is through printing, we also identified the menus used to printing slides.

NOW DO PRACTICE EXERCISE 19 ON THE NEXT PAGE.
Practice Exercise: 19

A. Outline the steps on how to print some pages of your presentation?

____________________________________________________________________
____________________________________________________________________
____________________________________________________________________
____________________________________________________________________
____________________________________________________________________
____________________________________________________________________
____________________________________________________________________

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 4.

Answers to Activity 1

1. You might want to print the slides of your presentation for backup purposes, in case presentation itself becomes un-available for certain reasons.
Lesson 20: Printing Handouts

Welcome to Lesson 20 of Unit 3. In Lesson 19, we described the steps on how to print slides, printed slides by following identified steps, and listed the importance of printing slides following the correct procedure.

In this lesson, we will print handouts and learn the importance of printing handouts by following correct procedure.

Your Aims:
- determine the correct process on how to print handouts for a Presentation
- print handouts

Printing Handouts
Read the following explanation of printing handouts and follow the steps in the hands on activity to learn how to print handouts. Be prepared to answer the questions that follow.

One of the good feature of PowerPoint is its ability to provide you with hard copy versions of the slides and/or of the outline text of a presentation. This is useful for the preparation of handouts for an audience or a class.

Handout is a printed copy of information provided free of charge.

Printing
In this part of the lesson we will print your presentation as handouts. This is a hands on practical exercise. Be sure you have a working computer with PowerPoint installed. This exercise will be more effective if you have a printer installed as well. If you did not understand some areas of this lesson, do not hesitate to start all over. We will now start the practical exercise.

1. Open a PowerPoint and create a new Presentation. Type the following in its equivalent slide, save your file with the filename — Printing Exercise —

Slide 1:

The Caves of the Kosua

By Stephen Read & Stephen McCullagh (an article from the "Paradise Magazine")
Slide 2:

The Location

Our base camp was in the village of Fogomaiyu. This is a small community located on the eastern slopes of the enigmatic Mount Bosavi. It is surrounded by the rainforests of the Upper Kikori in the Southern Highlands.

Slide 3:

The Local People

The region is the homeland of the Kosua people who have lived in complete isolation from the outside world until relatively recently. They retain a great deal of their traditional ways and the famous Papua New Guinea hospitality is on full show.

Slide 4:

The Expedition Team

The cavers were six Irish men and one German. An expedition from Australia helped manage access and interactions with the tribe.
Slide 5:

The Goal

To be the first people to record, map, explore and discover the caves and underground rivers that riddle the landscape to the east of Mount Bosavi and into the Darai Plateau.

2. From the **File Menu Tab** of the Ribbon bar choose **Print**.

3. Now click on the **Full Page Slides box** to bring up the drop down menu of print layout options. Refer to the image below.

4. In the drop down menu, under **Handouts**, select **6 Slides Vertical** per page.

5. Click in the **Colour** box towards the bottom of the Print dialog box.

6. In the Colour options for the slides, select **Grayscale**, then click on **OK** to print a copy of the presentation.
7. In the handout options, you can choose two, four, six, or nine slides per page. You can display the slides in order either horizontally or vertically.

This handout can then be distributed to an audience or a class for note-taking, review or reinforcement.

8. To print selected slides only (not the entire presentation), enter the page number of the slides that you wish to print in the box beside the Slides.

Refer to the image below.
Activity 1: What is the difference between printing a presentation as a handout and as a slide?

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Summary
You now have come to the end of Lesson 20. In this lesson you have identified the menus in printing handouts and printed your Presentation as a handout.
Practice Exercise:  20

A. Answer the questions.

1. Explain how to print selected slides when printing handouts.

______________________________________________________________
______________________________________________________________
______________________________________________________________
______________________________________________________________
______________________________________________________________
______________________________________________________________
______________________________________________________________

2. What happens to the printout when you select the Grayscale option before printing?

______________________________________________________________
______________________________________________________________
______________________________________________________________
______________________________________________________________
______________________________________________________________

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 4.

Answers to Activity 1

When you print a presentation as a slide, a single slide will be printed to a paper, while printing handouts allows you to choose to print multiple slides on a paper.
Lesson 21: Saving a PowerPoint Show

Welcome to Lesson 21 of Unit 3. In Lesson 20, we have identified the steps of printing handouts and stated the importance of printing them by following correct procedure.

In this lesson, we will describe the steps on how to save a PowerPoint Presentation and state the importance of following the correct steps in saving a PowerPoint Show.

Your Aims:
- identify the correct process on how to save a PowerPoint Show
- save a PowerPoint Show

Saving a PowerPoint Show
Read the following explanation of Saving a PowerPoint Show and follow the steps in the hands on activity to learn how to Save a PowerPoint Show, then be prepared to answer the questions that follow.

If you want to really impress people with your PowerPoint, save the file as a .ppsx. This is a PowerPoint Show. Most people save them as a PowerPoint Presentation (PPTX). A PPTX shows the slides and the work that can be done on the presentation. By saving as a PPSX (PowerPoint Show), when you double-click it, it will auto start into the show mode. It makes it look so much more professional. I have always seen presentations where people open the PPTX, then go to Slide Show > View Show. This cuts off that step. Using .PPSX is a shortcut to the show mode.

The file extension for a PowerPoint show is .ppsx (versions 2007 or 2010) or .pps (versions 2003 and earlier). The file extension for a PowerPoint presentation is .pptx (versions 2007 and 2010) or .ppt (versions 2003 and earlier). This file extension tells PowerPoint whether the file is ready for prime time (a PowerPoint show) or is still in the creation stage (a PowerPoint presentation).

In this part of the lesson we will be saving a presentation as a PowerPoint Show. This is a hands on practical exercise. Be sure you have a working computer with PowerPoint installed. If you did not understand some areas of this lesson, do not hesitate to start all over. We will now start the practical exercise. We will be creating a five slide presentation.
1. Slide 1:

“Papua New Guinea National Pledge”

2. Add the rest of the five slides with the corresponding texts:

Slide 2:

Click to add title

We, the people of Papua New Guinea pledge ourselves united in one Nation.
We pay homage to our cultural heritage, the source of our strength.

Slide 3:

Click to add title

We pledge to build a democratic society based on justice, equality respect and prosperity for our people
3. Select the first slide. Click Transitions Menu Tab from the Ribbon Bar.

4. From the Transitions to This Slide group, click the Reveal transition. You will see a preview of the Reveal transition the moment you have clicked it.

5. Select the second slide, from the Transitions to This Slide group, click the more button seen on the side. It will reveal more options for Transition animation. Click the Glitter transition. You will see a preview of the Glitter transition the moment you clicked it.

Click the more button (up and down arrow) to see more options of Transitions.
6. Select the third slide, from the Transitions to This Slide group, click the **more button** seen on the side. It will reveal more options for Transition animation, click the **Vortex** transition. You will see a preview of the Vortex transition the moment you click it.

7. Select the fourth slide, from the Transitions to This Slide group, click the **more button** seen on the side. It will reveal more options for Transition animation, click the **Blinds** transition. You will see a preview of the Blinds transition the moment you click it.

8. Choose **File → Save As**.

9. In the Save As dialog box, type a name for the file (if it is not already named) and then click on the drop down arrow for Save as type: Scroll to select the option **PowerPoint Show (*.ppsx)**.

Make sure that your presentation is edited and considered final before saving it to .PPSX file.
10. Click the **Save** button.

**How to view the saved .PPSX file**

Follow these steps when opening a saved .PPSX file:

1. Go to the folder where you saved the file (the common folder for files would be the "My Documents" folder),

2. Double click the PowerPoint file that you have just saved. It should look similar to the image below.

![PowerPoint Show Exercise.ppsx](image-url)

Every PowerPoint Show would have the same icon on the left and the .ppsx extension name at the end of the filename.
Importance of Saving as a PowerPoint Show
If you will be sending your file to a different place without you there you might want to save your file as a PowerPoint Show, so the audience will simply double click your presentation.

Activity 1: What is the advantage of saving a presentation as a PowerPoint Show?

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Summary
You now have come to the end of Lesson 21. In this lesson you have learned another way of saving a presentation and that is as a PowerPoint Show. You have also learned the steps and the importance of saving as a PowerPoint Show.

Now do Practice Exercise 21 on the next page.
Practice Exercise 21

A. Answer the questions.

1. What does the extension name .ppsx mean?

2. From what Tab would you see the Save as option?

3. Why is it important to save your presentation as a .PPSX?

Answers to Activity 1

Possible Answer:

The advantage of saving a presentation as a PowerPoint Show is that you can simply double click your presentation and it will already play. This will also prevent other people from editing your file.
Lesson 22: Saving Presentation as a Web Page

Welcome to Lesson 22 of Unit 3. In Lesson 21, we described the steps on how to save a Power Point Presentation, saved a Presentation following the correct steps, and stated the importance of following the correct steps in saving a Power Point Show.

In this lesson, we will list the steps to save a Power Point Presentation as a web page, save a Presentation as a web page and state the importance of using the correct steps in saving a Presentation as a web page.

Your Aims:
- identify the correct process on how to save a Presentation as a Web page
- save a Presentation as a web page

Web Page

Read the following explanation of Saving a Presentation as a Web Page and follow the steps in the hands on activity to learn how to Save a Presentation as a Web Page, then be prepared to answer the questions that follow.

Saving your Microsoft PowerPoint presentation as a web page allows you to then post it on the internet. PowerPoint is able to retain the presentation's integrity so that viewers on the web are able to see it as though the presentation was being run as normal.

Saving as a Web Page

An internet connection is a must for this part of the lesson. If an internet connection cannot be established, this exercise cannot continue to the final output.

In this part of the lesson we will be saving a presentation as a Web Page. This is a hands on practical exercise, be sure you have a working computer with PowerPoint installed and internet connection, we will now start the exercise, if you did not understand some areas of this lesson, do not hesitate to start all over. We will now start the practical exercise. We will be creating a five slide presentation.
1. Slide 1:

“The Sepik Magic”

Click to add subtitle

2. Add the corresponding text to the next slide:

Slide 2:

Just after sunset, when the colours of the Sepik give way to the glow of village fires, you can sit on the balcony of a rustic lodge high above the Karawari River and marvel at how technology can change lives at the drop of a hat.

Slide 3:

At first, your mind barely grasps it, for innovation can be a surprising intruder in secluded places of the world and the wild and little-visited Sepik, including this tributary, is as remote as it gets if you’re looking for soft adventure in Papua New Guinea.
3. Select the first slide. Click **Transitions Tab** from the Ribbon Bar.

4. From the **Transitions to This Slide** group, click the **Reveal** transition, you will see a preview of the Reveal transition the moment you clicked it.

5. Select the second slide, from the **Transitions to This Slide** group, click the **more button** seen on the side. It will reveal more options for Transition animation. Click the **Glitter** transition. You will see a preview of the Glitter transition the moment you clicked it.
6. Select the third slide, from the Transitions to **This Slide** group. Click the **more button** on the side. It will reveal more options for Transition animation, click the **Vortex** transition. You will see a preview of the Vortex transition the moment you click it.

Select the fourth slide, from the Transitions to **This Slide** group, click the **more button** on the side. It will reveal more options for Transition animation, click the **Blinds** transition. You will see a preview of the Blinds transition the moment you click it.

7. Click the **File** tab, and then click **Save & Send**. Under **Save & Send**, click **Save to Web**.

1. Click **File Tab** in the **Ribbon Bar**.
2. Select the **Save & Send** option.
3. Select **Save to Web** option under **Save & Send**.
4. Sign in to your **Windows Live Account**.

If you do not have a Windows Live account you can create one by clicking "Sign up for Windows Live"
You need to sign-in or sign-up for a **Windows Live Account** for you to progress to the next step. If you have an internet connected to your computer you can follow this step to be able to create an account with Windows Live. If you already have an account just click Sign In and enter your username and password.

1. Click the **Sign up for Windows Live** and you will be directed to the page similar to the image below.

![Image of Windows Live account creation page]

2. Fill in and complete the details needed. Example, your name, username (this should be your existing e-mail address), and password.

3. Be sure to fill in the whole form and do not leave a blank. Once you are done and is successful in creating an account an image similar to the one below will appear.
4. After creating the account, you need to verify if your email address is valid. To do this, you have to go to your email address and click the verify link in there. A verify email and button will be similar to the one below.

5. Once you have verified the email address, an image like the one below will appear.

8. Sign in to your Windows Live account.

9. Under the Microsoft OneDrive, select Public.
10. Click **Save As**.

11. In the **File name** box, type a file name, or do click the Save button to accept the default filename. Refer to the image below for the final output.

Web Server is simply a computer program that serves **web pages** to the user as they are requested.

Web pages are what make up the World Wide Web. These documents are written in HTML (hypertext markup language) and are translated by your Web browser.

Note: If you want people to have access to a presentation that you published to the Web, you must specify a **Web server** or other available computer when you choose a location for the file.

**Activity 1:** What is the advantage of saving a Presentation as a web page?
Thank you for completing this activity. Now, you may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.

Summary
You now have come to the end of Lesson 22. In this lesson you have learned another way of saving a presentation as a web page. We have also enumerated the steps in saving as a web page and put it in practice.

NOW DO PRACTICE EXERCISE 22 ON THE NEXT PAGE.
A. Answer the following questions.

1. Once the presentation is saved as a webpage, it is translated into a different document, which is called _________________.

2. What must you have before you can save your presentation as a web page?

   ______________________________________________________________

3. In your own words state the advantages and disadvantages of saving your presentation as a Web page.

   ______________________________________________________________
   ______________________________________________________________
   ______________________________________________________________
   ______________________________________________________________
   ______________________________________________________________
   ______________________________________________________________

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 4.

Answers to Activity 1

1. You can save a presentation as a web page if you want to post your presentation on the world wide web. Posting your presentation on the web makes it accessible even to those who are half way around the world.
Lesson 23: Saving with Pack and Go

Welcome to Lesson 23 of Unit 3. In Lesson 22, we have described the steps on how to save a PowerPoint Presentation as a web page using the correct steps and stated the importance of saving a Presentation as a web page.

In this lesson, we will identify the steps on how to save a PowerPoint Presentation with Pack and Go and state the importance of following the correct process in saving with Pack and Go.

Your Aims:
- identify the correct process on how to save with Pack and Go
- save a Presentation with Pack and Go

Pack and Go

Read the following explanations of Saving a Presentation with Pack and Go and follow the steps in the hands on activity to learn how to Save a Presentation with Pack and Go, then be prepared to answer the questions that follow.

"Where is Pack and Go in Microsoft Office PowerPoint 2003?" This feature has been improved and renamed Package for CD.

Microsoft PowerPoint 2003
Now, when you quickly copy your presentation along with any supporting files to a disk or network location, the Microsoft Office PowerPoint Viewer is included by default. That way the PowerPoint Viewer will be available to run the packaged presentations on another computer even if PowerPoint is not installed.

Or, if you are using Microsoft Windows XP or later versions and have a CD burning program, you can copy the presentation and supporting files onto a CD.

**Saving a PowerPoint Presentation with Package for CD**

In this part of the lesson we will save a presentation with Package for CD. This is a hands on practical exercise. Be sure you have a working computer with a CD/DVD burner and PowerPoint installed. This lesson will also be easily followed if you have a blank CD/DVD for burning your presentation. If you did not understand some areas of this lesson, do not hesitate to start all over. We will now start the practical exercise.

1. **Slide 1:**

   ![Slide 1](image)

   **It’s the Eel Thing**

   Click to add subtitle

2. **Slide 2:**

   ![Slide 2](image)

   **Click to add title**

   Eels are not “slimy”. These wonderful animals have been totally misunderstood and often slandered. As usual though, as with any great deception, there is a germ of truth in the label, and it is the fault of fisherpersons.
3. Select the first slide. Click **Transitions Tab** from the Ribbon Bar.

   ![The Transitions Tab]

4. From the **Transitions to This Slide** group, click the **Reveal** transition, you will see a preview of the Reveal transition the moment you click it.

   ![Select the Reveal Transition.]

---

If you assault an eel by hook or spear and drag it out of its natural environment, yes, it produces slime on its skin as it fight for its life. On occasions, freshwater eels wriggle across land and perhaps slime helps them to move.

But underwater, in their happy element, eels are sublimely smooth. They are wonderful to touch, soft, sleek and, yes, slicker than silk.
5. Select the second slide, from the Transitions to This Slide group, click the **more button** seen on the side. It will reveal more options for Transition animation. Click the **Glitter** transition. You will see a preview of the Glitter transition the moment you click it.

6. Select the third slide, from the Transitions to This Slide group. Click the **more button** seen on the side. It will reveal more options for Transition animation, click the **Vortex** transition. You will see a preview of the Vortex transition the moment you click it.

7. Select the fourth slide, from the Transitions to This Slide group, click the **more button** seen on the side. It will reveal more options for Transition animation, click the **Blinds** transition. You will see a preview of the Blinds transition the moment you click it.

8. Click the **File** tab, and then click **Save & Send**. Under **Save & Send**, click **Package Presentation for CD**.

---

**The arrows in the image points at the correct options for saving Presentation for CD.**
9. In order to distribute your PowerPoint files in a CD or package for CD, you need to click on File and then Save and Send. Here you will see an option that says Package Presentation for CD.

<table>
<thead>
<tr>
<th>Package for CD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy a set of presentations to a folder on your computer or a CD.</td>
</tr>
<tr>
<td>Name the CD:</td>
</tr>
<tr>
<td>Files to be copied</td>
</tr>
</tbody>
</table>

Type the name of your CD here. For this exercise your CD will be named PresentationCD.

This Box contains the files you wish to burn on a CD, select the file that you will save on a CD.

Click Copy to CD to finalise the saving on file to a CD.

Importance of Saving with Package for CD
When there is a need to record or distribute PowerPoint presentations, consider burning them to CD. Burning a complex PowerPoint presentation properly sometimes consists of more than simply copying a single PowerPoint (PPT) or PowerPoint XML (PPTX) file to a CD. If your presentation contains links to media files, for example, you must burn those to CD as well.

Activity 1: Give the advantage of saving a Presentation with Pack and Go.

__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________

Thank you for completing this activity. Now, you may go to the end of this lesson to check your answer. Make sure you do the necessary corrections before moving on to the next part of this lesson.
Summary
You now have come to the end of Lesson 23. In this lesson you have learned another way of saving a presentation and that is with Package for CD. You also completed a practical exercise of saving with Package for CD.

NOW DO PRACTICE EXERCISE 23 ON THE NEXT PAGE.
Practice Exercise: 23

A. Answer the questions.

1. The Pack & Go feature of PowerPoint 2003 was replaced with what in PowerPoint 2010?

2. Why use Pack & Go feature when copying to a CD instead of cutting and pasting?

Answer to Activity

1. Saving a presentation using the Pack & Go gives us the advantage of taking our presentation anywhere without worrying if the multimedia such as video, music, and others included in the presentation was not attached properly.
Lesson 24: Evaluating the Presentation

Welcome to Lesson 24 of Unit 3. In Lesson 23, we have described the steps on how to save a Power Point Presentation with Pack and Go and stated the importance of saving with Pack and Go.

In this lesson, we will list the criteria and standard norms in evaluating a Presentation, use the identified criteria and standard norms to evaluate a Presentation and state the importance of using them in evaluating a Presentation.

Your Aim:
- evaluate a Presentation using standard norms and criteria

Evaluating the Presentation

Read the following explanations of Evaluating the Presentation, then answer the questions that follow.

A PowerPoint presentation is just another form of communication. This lesson offers guidelines for using and assigning PowerPoint presentations for classroom use or during special reports and includes a rubric based on the Five Features of Effective Writing.

Rubric is a document that clears the expectations for an assignment by listing the criteria, or what counts, and describing levels of quality from excellent to poor.

It is possible to use PowerPoint as part of a presentation that is thoughtful, educational, and encouraging of higher-order thinking, that gives students a chance to apply, synthesize, and evaluate information rather than merely reciting it. PowerPoint can be a powerful tool for enhancing good presentations, but it is not a support for poor ones.

So when you use PowerPoint think carefully about what your educational purpose is, and always keep that in mind. Do not let the typical style of PowerPoint drive your content and educational purpose. Put the content first and find a style that reflects it.

When you consider adding a multimedia aid such as a slideshow to your presentation, keep the following in mind.

1. Communication is everything.
   Always remember that a presentation aid (such as a PowerPoint Presentation) is a vehicle for communication. Before you design a
presentation, ask yourself “What am I trying to communicate?” “What ideas, information, or emotions do I want my audience to take away?”

Every decision you make from that point forward affects your Presentation. For example: Does the music “C laps Cheer” communicate something important about your topic, or is it just pleasant to listen to? If it is just pleasant to listen then it is not important and it will just distract your audience. Does that piece of Clip Art communicate anything at all? Do flying and exploding slides enhance communication or merely distract your audience?

All parts of your Presentation should be related and meaningful to your content.

2. **Technology is only a tool.**
   If the slideshow has no value apart from its content, neither does the technology. Remember that technology and its use should come together.

3. **Communication goes both ways.**
   Your Presentation should encourage discussions. Presenters should always explain well on the text and images in their presentations. The audience should be expected to listen and respond thoughtfully to that sufficient explanation — not just to the bullet points on the screen.

4. **Make your assessment reflect your priorities.**
   Finally, when you evaluate presentations, **judge the content first.** It is tempting, and easy, to give lots of points for artfully designed slides and clever use of Clip Art. But remember our first two rules: **it is not about the presentation,** at least not primarily. So, when designing a rubric for multimedia presentations:
   I. Judge the content first. What has the audience learned?
   II. Next, judge the communication. How effectively does the presentation communicate what the audience has learned?
   III. Last, judge the presentation. How effective is the presentation?
   In short, you can evaluate a presentation essentially the way you would a piece of writing, with the content of the writing first and the mechanics (grammar and spelling) last. You might want to think about presentations in terms of a version of the Five Features of Effective Writing: focus, organization, support and elaboration, style, and standards, in that order.

**Activity 1:** How can you properly use PowerPoint for your presentation?
Thank you for completing this activity. Now, you may go to the end of this lesson to check your answer. Make sure you do the necessary corrections before moving on to the next part of this lesson.

The Six Features of Effective Presentations: A Rubric

Here is a simple rubric for evaluating a PowerPoint presentation based on the features of effective writing. Remember, if you are trying to improve a presentation rather than merely grade it, think about the features in this order.

Focus
What's the point of this presentation? What primary information is the presenter trying to communicate? Ignore the appearance of the slides for the moment.

- **4 points** — The presentation had a clear and consistent focus.
- **3 points** — By the time he or she finished, I understood the presenter's point clearly, but I had some doubts along the way.
- **2 points** — I am fairly certain what point the presenter was trying to make, but I would like further clarification.
- **1 point** — On further reflection, I think I can figure out what the point of this presentation was, but I should not have to work this hard.
• **0 points** — I have absolutely no idea what this person was talking about.

**Organization**
Are the slides presented in an order that makes logical sense and supports the **focus** of the presentation? Is the overall plan of the presentation evident and consistent? Is the information on each slide presented in a logical manner, with clear titles, headings, paragraphs, and bulleted or numbered lists?

• **4 points** — At every point in the presentation, I knew exactly where the presenter was and where we had been, and I had a sense of where we were going. I never lost sight of the presenter’s focus.

• **3 points** — I generally knew where the presenter was and where he/she was headed, but there were a couple of places where I was a little confused. Some of the slides may not have been clear, and a couple seemed outside the focus of the presentation.

• **2 points** — I was never totally lost during the presentation, but several of the slides were unclear or confusing, and there were several places where I was not sure where the presenter was headed. Several of the slides seemed to move away from the main point, and it was sometimes difficult to tell what was a page title, what was a heading, and what was regular text.

• **1 point** — By the time the presenter finished, I understood what the focus was, but most of the slides seemed jumbled.

• **0 point** — I was lost during most of the presentation. Few if any of the slides seemed logical when presented.

**Support and Elaboration**
Is there enough supporting information or arguments in the presentation to make the main point effective? Were any of the slides (or the content on the slides) irrelevant to the presentation’s focus? Consider not only text but images. If images accompany the text of slides, do they support the presenter’s point, or are they just decorative?

• **4 points** — There was plenty of supporting information, evidence, images, etc. to make the presenter’s point. I am thoroughly convinced!

• **3 points** — The presenter provided enough support for his/her argument, but some images seemed purely decorative, and a couple of bullet points needed further clarification.

• **2 points** — There was a fair amount of supporting information, but it was too little. The presenter did not sufficiently elaborate on many of the bullet points, and the images added little to my understanding of the issue.

• **1 point** — The presenter relied too heavily on short bullet points in the PowerPoint presentation and didn’t provide sufficient oral elaboration. The images were purely decorative and added nothing to my understanding of the issue.
• 0 point — The presenter gave virtually no evidence at all for his or her argument.

Style
With respect to a PowerPoint presentation, style refers both to the style of the writing and to the appearance of the slides. Do word choice, sentence fluency, and voice reflect the presenter's purpose and audience? Similarly, do the layout and design of the slides, the fonts, and the images reflect the presenter's purpose and audience?

In short, keep it simple. Certainly you want the appearance of the slides to be interesting, and the presenter's personal voice can still come through, but the content has to come first. Unnecessary Clip Art, overly bright and distracting colours, big headers that crowd the text of pages, and so on will only distract the audience.

• 4 points — The text and the visual design were clear, interesting, and appropriate to the purpose and audience of the presentation.

• 3 points — The text and visual design were clear and interesting but somewhat inconsistent in style. Although the design may not have distracted from the content, it also did not enhance my ability to understand the presentation.

• 2 points — The layout and colour choices distracted somewhat from the content of the presentation, and some of the images were purely decorative and seemed out of place.

• 1 point — Fonts and colours were inconsistent; text was dull and inappropriate to the presenter's purpose (too informal, for example).

• 0 point — Colours, fonts, and layout seemed almost random. The design was confusing and made it difficult to understand (or even find) the content of the presentation.

Standard
For a PowerPoint presentation, this includes the standard of writing (grammar, spelling, and usage) as well as the layout of slides, legibility, and timing. Was the text free of errors in grammar, spelling, and usage? Was the layout of the pages consistent and clean? Was the text easily readable, and headings clearly distinguished from regular text?

• 4 points — The presentation was easy to read; text was free of errors.

• 3 points — There were one or a few errors in grammar, spelling, or usage, but they did not detract from the content. Text was clear and easily readable.

• 2 points — There were several errors in grammar, spelling, or usage. Text was not as readable as it could have been.

• 1 point — The presentation was staded with careless errors that detracted from the content. The layout of the slides was inconsistent and made comprehension difficult, and the text was often difficult to read.
•  **0 point** — Problems with grammar, spelling, usage, layout, and font choices made this presentation nearly beyond understanding.

**Presentation skills**
Because PowerPoint presentations need to be accompanied by a real, live human being to be effective, you will need to evaluate the presenter's skill in speaking and in responding to the audience.

•  **4 points** — The presenter gave a clear, thorough, convincing presentation apart from the PowerPoint. The PowerPoint enhanced the presentation and was useful as a reference, but I felt that the presentation would still have been quite good without it. The presenter welcomed questions from the audience and responded thoughtfully.

•  **3 points** — The presenter spoke well and with confidence but occasionally read bullet points without sufficient elaboration. In some cases, he/she diverted from the "script" a little too much.

•  **2 points** — The presenter spoke with some confidence but relied heavily on the text on the screen. This probably would not have been a strong, coherent presentation without the PowerPoint to hold it together.

•  **1 point** — The presenter mostly read the bullet points on the screen, only occasionally elaborating on them. He/she looked at the screen as much as at the audience and faded when responding to questions from the audience or speaking independently.

•  **0 point** — The presenter merely read the bullet points on the screen, then referred back to them in response to questions. It seemed almost as though he/she had never seen the PowerPoint before today.

**Activity 2:** Evaluate the whole Presentation using the given criteria found on page 201. Encircle the number of your choice, wherein 4 is the highest and 1 the lowest.
It is caused by the human immunodeficiency virus (HIV).

AIDS originated in sub-Saharan Africa in the 20th century.

AIDS infects vital organs of the human immune system, ...

...destroys vital cells required for the functioning of the immune system, ...

...and results in fevers, sweats, swollen glands, chills, weakness, and weight loss.

Ultimately, AIDS kills.

Over 38.6 million worldwide have AIDS.

25 million have already fallen prey to AIDS.
There is no known cure.

The AIDS virus spreads through contact of blood,...

...and prevention of blood contact is the only respite.

AIDS is a huge emotional issue,...

...AIDS infected people need to be treated with love and care.

AIDS does not spread with normal human contact.
### Criteria

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Excellent</th>
<th>Very Good</th>
<th>Satisfactory</th>
<th>Poor</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Focus</strong>&lt;br&gt;The Presentation had a clear and consistent focus</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td><strong>Organization</strong>&lt;br&gt;Are the slides presented in an order that makes logical sense and supports the focus of the presentation?</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td><strong>Support &amp; Elaboration</strong>&lt;br&gt;If images accompany the text of slides, do they support the presenter's point, or are they just decorative?</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td><strong>Style</strong>&lt;br&gt;do the layout and design of the slides, the fonts, and the images reflect the presenter's purpose and audience?</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td><strong>Standard</strong>&lt;br&gt;Was the text free of errors in grammar, spelling, and usage? Was the layout of the pages consistent and clean?</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
</tr>
</tbody>
</table>
Thank you for completing this activity. Now, you may go to the end of this lesson to check your answers. Make sure you do the necessary corrections before moving on to the next part of this lesson.

---

**Summary**

You now have come to the end of Lesson 24. In this lesson you have learned that there is a proper way of creating a presentation given the four rules. You have also learned that a presentation is evaluated using a criteria and proper norms such as the rubric.

---

**NOW DO PRACTICE EXERCISE 24 ON THE NEXT PAGE.**
Practice Exercise 24

A. Fill the Evaluation Sheet with your own criteria (follow the rubric method in the reading), base the criteria of your evaluation from the presentation given.
### Criteria

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Excellent</th>
<th>Very Good</th>
<th>Satisfactory</th>
<th>Poor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Focus (The Presentation had a clear and consistent focus)</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>Organization (Are the slides presented in an order that makes logical sense and supports the focus of the presentation?)</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>Support &amp; Elaboration (If images accompany the text of slides, do they support the presenter’s point, or are they just decorative?)</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>Style (do the layout and design of the slides, the fonts, and the images reflect the presenter’s purpose and audience?)</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>Standard (Was the text free of errors in grammar, spelling, and usage? Was the layout of the pages consistent and clean?)</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
</tr>
</tbody>
</table>

---

**CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 4.**

### Answers to Activity 1

1. To properly use PowerPoint for a presentation, you must follow these guidelines:
   - Presentation is a vehicle for communication, be sure that all the design aspects you put in your presentation is relevant to the message you wish to pass to your audience.
   - Technology is only a tool, do not think that your audience will understand your presentation only by watching your slide, you as the presenter must be there to explain.
   - Communication goes both ways, an effective PowerPoint presentation should not only entertain the audience but you must also provide a room for argument about your topic, put a question slide, for your audience to discuss after your presentation.
   - Make your assessment reflect your priorities, judge the content, your first priority is that your audience will learn something from your presentation.
Answers to Activity 2

1. The second activity is an evaluation there is no right or wrong answer, but the students should be able to answer the evaluation based on the reading prior the activity.
Answer to Practice Exercises

Practice Exercise 19
1. There is an option to print only selected slides. In the Print command, under the Settings, click the arrow down button beside Print All Slides and select Print Selection, and enter the page of your selected slide that you wish to print.

Practical Exercise 20
1. Yes, simply enter the page number of the slide you wish to print in the box beside the Slides, in the Settings option of the Print command.
2. The printout will come out in shades of white and black only (not coloured) if you select grayscale before printing.

Practical Exercise 21
1. PowerPoint Show
2. File Tab
3. Saving with the file name .pptx means you have saved the presentation as a PowerPoint Show, wherein you simply double click the presentation and it will auto start the show.

Practical Exercise 22
1. Hyper Text Markup Language (HTML)
2. Web Server
3. The advantages of publishing your presentation to the web are the presentation is available to you and other people anytime provided that you have internet access. The disadvantage of publishing your presentation to the web is that it can be expensive since it needs internet connection to be published and viewed.

Practical Exercise 23
1. Package for CD
2. When you want to copy your presentation to a CD it is important to use the Pack & Go feature so to be sure that all the multimedia files that is included in your presentation will be copied as well.

Practical Exercise 24
Students should be able to fill the evaluation sheet and could come up with criteria similar below.
<table>
<thead>
<tr>
<th>Criteria</th>
<th>Excellent</th>
<th>Very Good</th>
<th>Satisfactory</th>
<th>Poor</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Focus</strong></td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>The content of the slides describes the title of the presentation.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Organization</strong></td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>The slides are presented in proper order, wherein the easiest topic is presented on the first slide and the more complicated on the last slide</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Support &amp; Elaboration</strong></td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>There are supporting images and texts to the main points of the presentation</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Style</strong></td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>Text are written clearly and slide design does not distract the audience from its content</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Standard</strong></td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>Text are free from spelling and grammar error</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

End of Topic 4.

Now Do Exercise 4 in Assignment Book 4.
**Animation.** Is the illusion of movement created by showing a series of still pictures in rapid succession.

**Animation Effects.** A set of effects which can be applied to objects in PowerPoint so that they will animate in the Slide Show Power Point.

**Area Charts.** Emphasize the magnitude of change over time.

**Audio.** Is a term used to describe any sound or noise that is within a range the human ear is capable of hearing.

**Audio Clips.** A brief recorded file, linked to a website or to an electronic message, used to relay audible information from one user to another.

**Bubble Charts.** Is a type of XY or scatter chart that compares sets of three values and can be displayed with a 3-D visual effect.

**Charts.** Are visual representations of data.

**Clip Art.** Is a pre-made images used to show any forms of objects.

**Clustered Bar Chart.** This type of chart compares values across categories.

**Column Charts.** Show data changes over a period of time or illustrate comparisons among items.

**Colour Scheme.** Is the choice of colours used on the page.

**Content Template.** It has all the elements of a design template plus a suggested outline for the presentation.

**Copyright.** The exclusive and assignable legal right, given to the originator for a fixed number of years, to print, publish, perform, film, or record literary, artistic, or musical material.

**Cropping.** To reduce the size of an image or to remove non-important aspects of an image.

**Custom Animation.** Is a set of effects which can be applied to objects to animate in the Slide Show.

**Customise/Customizing.** To make or alter to individual or personal specification

**3-D Column Chart.** This type of chart compares data points along two axes.
**Deselect.** Means to un-select something you already ticked.

**Design Template.** Refers to the specific look of a slide or group of slides.

**Design Tab.** Tab which contains the basic slide formatting tools.

**Doughnut Chart.** Shows the relationship of parts to a whole.

**Dummy.** An imitation, representation, or copy of something, mainly used in a display or demonstration.

**Electronic Memory.** Refers to the parts of a computer that keep hold of data for some period of time, possibly even after the computer in turns off.

**File Extension.** Is the suffix (separated from filename by a dot), which shows what kind of file it is.

**Flowchart.** Is a diagram of the order of operations in a computer program.

**Handout.** Is a printed information provided free of charge.

**Hardware.** Is the mechanical, magnetic, electronic, and electrical components making up a computer system.

**HTML.** Also known as Hyper text Mark Up Language.

**Hyperlink.** It is commonly called, a link, allows the viewer to quickly access another screen on the computer by simply clicking on a text entry or a graphic object.

**Image.** Is a binary representation of visual information such as drawings, pictures, graphs, logos, or individual video frames.

**Interactive.** Allowing a two-way flow of information between a computer and a computer-user.

**Legibility.** Is the level to which individual characters in text are understandable or recognizable based on appearance.

**Line.** This type of chart display trend over time or categories.

**Line Charts.** Show trends in the data at equal intervals.

**Media.** Commonly known as digital media or medium. It is a term used to describe any type of computer storage.
Multimedia. Is the combination of multiple forms of media. This includes text, graphics, audio, video and so on.

My Documents. Is a folder that stores documents, program settings and other files.

Normal View. It is the main editing view, where you write and design your presentations.

Notes Page View. The Notes pane is located under the Slide pane.

Notes Pane. Appears at the bottom of the screen. Click on the notes pane to add, edit, or delete, or delete notes that relate to each slide’s content.

Pack and Go. Is a feature of PowerPoint that compresses files and includes files related to your presentation for transporting to a different computer.

Placeholder. Is a box with a dotted outline. It designed for the placement of content on the slide.

Pie Charts. Circular chart that is sliced into sections which represents a percentage.

Print Selection. This gives you a choice to print only a slide that you want and not the entire presentation.

PowerPoint. A software package designed to create electronic presentations consisting of a series of separate pages or slides.

PowerPoint Design Template. The template that can be applied to all slide or selected slides.

Outline. Is a blueprint or plan of your presentation.

Quick Access Toolbar. Is most of the time a bar across the top that contains buttons that execute commands when you click them.

Radar Chart. Compare the aggregate values of a number of data series.

Reading View. This view use to deliver the presentation not to an audience, but instead to someone viewing the presentation in the computer.

Ribbon Bar. Is a horizontal strip that contains lists of available Tabs, Groups, & Commands for a certain program. It resides at the top of each open screen.

Rubric. Is a document that clears the expectations for an assignment by listing the criteria, or what counts and describing levels of quality from excellent to poor.
**Router.** Is a device that connects two networks over large distance. **Search Engine.** Are programs that search **Server.** It is a machine with a large storage capability that can be shared with number of user.

**Slide.** Is a single page of a presentation created with software such as PowerPoint.

**Slide Pane.** Is a feature available in some programs, usually found on the left side of the window, which displays thumbnails of available files or features available in the program.

**Slide Show View.** It is use to deliver presentation to the audience. This view occupies the full computer screen, exactly the way will look on a big screen when the audience sees it.

**Slide Sorter View.** View that gives you a view of your slides in a thumbnail form.

**Status Bar.** Shows the current page number and position of the insertion point in the document.

**Stacked Bar Chart.** This type of chart shows the relationship of individual items to the whole.

**Stacked Column.** This type of chart shows the relationship of individual items to the whole.

**Storyboard.** Is a sequence of drawings, typically with some directions and dialogue, representing the shots planned for a movie or television production.

**Surface Charts.** Are useful when you want to find optimum combinations between two sets of data.

**Task Pane.** Enables the user to have a quick access to common features, information, and commands.

**Text Effect.** Adds shadow, reflection, or glow to a text. It also can change the direction of a text.

**Text Fill.** Adds colour, gradient (blending of shades from light to dark or from one colour to another), and/or picture inside a text.

**Text Outline.** Adds a line marking in the outercurve or boundary of a text.

**Title Bar.** Displays the document name followed by proram name.

**Video.** Is an electronic medium for recording, copying and broadcasting of moving visual images.
**Web Browser.** Is an application software or program designed to enable users to access, retrieve and view documents and other resources on the internet.

**Web Pages.** It makes up the World Wide Web. These documents are written in HTML and are translated by the web browser.

**Web Server.** Is simply a computer program that dispenses web pages as they are requested.

**WordArt.** Is a tool that gives some dramatic, pre-designed styles for formatting text.

**XY (Scatter) Charts.** Show the relationship among the numeric values in several data series.

**Yahoo.** Is an internet doorway that includes a search engine and a directory of World Wide Web sites organized in a ladder of topic categories.